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Introduction to Basic Cataloging

The purpose of this workflow-based reference guide is to provide a basic
introduction to the features and workflows for the Cataloging subsystem of the
Virtua™ ILS - Integrated Library System. The intention of this guide is to highlight
the various methods and functions and to provide concise, intuitive instructions for
performing tasks related to cataloging library materials and manipulating records.

Whether performing original cataloging or importing records this guide will outline
the steps needed to perform these functions, as well as covering the settings and
configurations required to save the records into your database.
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Understanding Menu & Toolbars

Language and Directionality Options
Language and Directionality options can be set from the Options pull-down menu.

Language

Select a language from the menu list.

Any translated strings for that language will appear in the Client interface.

W Virtua - Headquarters - Customer Support Library

=0/

File Search Circulation Acguisiions Cataloging  Options Tools Window Help
W @O | &R €GE g PO "l v BD B
Default connection: Customer Support Library - staff Language 4 Arabic |
Font Azeri
Hyperlink Options. .. Catalan
Directionality r Chinese
] Chinese Trad
Change Location... Danish
Circulation Options Dutch
Sort Patron Account by Location English
Cataloging Options... Finnish

Basic Cataloging Workflow-Based Reference Guide
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Label Editor...
Load Options...
Available Languages. ..

Toolbars

French (Belgium)
French (France)
French (Switzerland)
German

Gresk

Hebrew

Hindi

Icelandic
Indonesian
Inuktitut

Irish

Italian
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Directionality
Select Left to Right soft and all text, regardless of directionality, will left justify

Select Left to Right Soft text that is left-justified text will display left justified
and right-justified text will display to the right.

Select Right to Left and all the text, regardless of directionality, will right justify.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging  Options Tools  Window Help

9 T W& i ] b, "
W @O | £ %@ GE| g OPACOPe IR =R
Default connection: Customer Support Library - staff Language v

Font
Hyperlink Options. .. |
Directionality r ® Left To Right ‘

Left To Right Soft

Change Location. ..
ange ~-ocafion Right To Left

Circulation Options ¥
v Sort Patron Account by Location

Cataloging Options. ..

Label Editor...

Load Options...

Available Languages. ..

Toolbars r
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Virtua File Menu

W Virtua - Headquarters - Customer Support Library

==X

W @0

File Search Circulation Acquisiions Cataloging Options Tools Window Help

AR eSEH AaBE N - QX &

Default connection: Customer Support Library - staff

Current connection: Customer Support Library - staff

B DR G

Menu bar Icon | Function | Function
Keys

File

Records

Create Select a template to create a MARC
record

Delete Select a file of local records or a
single local record to delete

Edit Local Select a file of local records to edit

Edit Item Modify various elements of item
records with the Batch Item Editor.

Translate Display the Batch Character Set
Translation panel to convert a file of
local records to the Unicode character
set

Import Records Imports records from OCLC, other
bibliographic utilities, and local files

Import to Selection Imports records from a source file

List directly to the Purchase Request List.

Workform

Edit Select a workform to edit

Delete Select a workform to delete

Close Close multiple records or workforms
without closing the Editor itself

Save Record Save changes made to an existing
local record

Save Record As Save local record to a different file or
overwrite an existing local record with
new changes

Append Record To Add record to an existing file of local
records

Save Copy to Duplicates a MARC record and saves it

Database to a designated database

Save to Database F11 Save the record and create index

Delete Record from
Database

Delete

Basic Cataloging Workflow-Based Reference Guide
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entries
Remove record from the database and
delete index entries

Select a workform to delete
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Virtua Edit Menu

¥ Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools  Window Help

WO AL eCE BE N - QX & - BDLOBE

Default connection: Customer Support Library - staff Current connection; Customer Support Library - staff

Menu bar Ico | Short Cut Function
n
Edit
Cut Ctrl X Cut selected text
Copy Ctrl C Copy selected text
Paste Ctrl V Paste Selected text
Add Tag Shift, Ctrl, A | Add MARC tag
Copy Tag Shift, Ctrl, C | Copy MARC tag
Paste Tag Shift, Ctrl, V | Paste MARC tag
Paste Tag to All Paste MARC tag into all open
MARC records
Delete Field Shift, Ctrl, D | Delete MARC tag
Validate Record AltE, V Starts record validation
Icon only ] Insert 008 tag
Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
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MARC Editor Window

The MARC Editor can be used to:

e Create a new record (original cataloging)
e Edit a MARC record from the Virtua database
e Edit a MARC record from a local diskette, hard drive, or network drive
e Edit a MARC record from a bibliographic utility or Z39.50 compliant database
i MARC Editor - Phoenix99 =< Tags, Indicators, and
[iisonozs3299 <4 Fields:
[ricFayc = Virtua provides a layout of the

o
(=)
[}

[ 20070115000800.0 | tags, indicators, and fields for
| each type of MARC or 2709
format record/workform that
|2 2004-022663 | Virtua Supports.
|
|

| 040927520058 nyub 0001 eng

Q2|2
=12
[ ) el i

| 'a 0316011770 :\z $30.95

(][ g e

=
)
(i}

[ = (oLCy2004022563

i3 200701130005 b WLOAD o 200508050349 '
btaylor \o 200506080837 W btaylor o 200503071 745
'y 200503071745 '= mmcarthu

=
(5]
o

| va DLCw DLC W GCmET

EEELE
[ 2 F 2 kOSTOVA,

{5 53 |

N I |

FJFEE
%DED CICICIE

[ 2 Kostovs, Elizabeth,

|(a) Language material L| () Monographitiem - u_ lazked Type and Bib Level
| = MARC 21 Bib: Book OPAC Options:
YWOPACT §
The MARC Editor provides a
. . pull-down list boxes showing
Tracking Information Bar: Type and Bib Level Options.
Tabs: The information bar at the boftom pf the The codes for the selected
) MARC Editor window indicateq thref thipgs: options are displayed from
The MARC the Leader of the MARC
Editor keeps | MARC21 Bib: Baok opec | Noitied record.
track of the N —
records or The type of record being created|or
workforms that edited: USMARC Bib: Book.
you create or
access during
the current .
session. Whether it is a workform or a record
and if a record, whether it is New,
‘&,—T;;‘@,L{ Local, or accessed from the OPAC.
If typing the first entry into the MARC =
Editor or adding or deleting a tag has
changed the record, the word Modified
appears on the Information Bar.
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MARC Editor Menu Options

W Virtua - Headquarters - Customer Support Library E]@
File Edit Search MARC Editor Circulation Acquisiions Cataloging Options Tools  Window Help

g{ . o o Create Authority Record(s)... T N B Q;g ﬂ E ﬁ L B0 iEE
Default connection: ¢ nt connection: Customer Support Library - staff

Duplicate Record in Mew Window
Merge Record with Workform...
Card Screen Preview...

Export to VTLS Format...

Femember for Thank You Letter
Insert Unicode Control Character »

¢ Create Authority Records: Allows you to create authority from selected
headings information in an open MARC record.

e Authority Browse: Opens the Browse Search window populated with the
information from the selected tag.

e Authority Keyword: Opens the Keyword Heading Search window populated
with the information from the selected tag.

¢ Duplicate Record in New Window: With a record or workform open in the
MARC Editor, this feature allows you to open a new window that duplicates
the first.

¢ Merge Record with Workform: With a MARC record open in the MARC
Editor, you can add tags by merging the record with a workform. Tag not in
the record but that are in the workform will be added to the record.

e Card Screen Preview: Allows you to preview the “public view” of the record
you are editing.

e Export to VTLS Format: Converts records to MARC 2709 format. Re-maps
001/035 tags to VTLS Classic format.

¢ Remember for Thank You Letter: While the record of a gift or deposit is
open in the MARC Editor, lets you append the data in the 541 tag to a file to
be used in printing Thank You Letters or acknowledgments.

e Insert Unicode Control Character: Unicode Control Characters are tags
that help with text flow and direction for languages such as Hebrew and
Arabic that are right justified.
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Documentation and Help

Virtua Users Guides are available in searchable .pdf format from the Tools
menu; click on the Tools menu, then select Documentation Search Engine. The
Documentation Search Engine appears on your Tools menu by default, it is
functional only if the Virtua documentation has been installed via the
Documentation Installer. For details on the Documentation Search Engine, see the
section Getting Help with Virtua: Viewing and Searching the Virtua Documentation
in the Virtua Client Getting Started Primer.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options  Tools  Window Help
@0 | A% €©GE A BE 00 Comeen - BDB S
Default connection: Customner Suppart Library - staff Notepad
WordPad

On Screen Keyboard
Documentation Search Engine

The Help Menu links to detailed information about MARC 21, CATMARC,
SWEMARC, and UNIMARC Format.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools Window  Help
W OHO £ 2 ©CH MBE N| | M2t i
MARC21 Bib Help L
Default connection: Customer Suppaort Library - staff MARC 21 Haldings Help

MARC21 Community Info Help
Patron MARC Help

CATMARC Help
CATMARC Leader 06 Help
UMIMARC Bib Help
UMIMARC Auth Help

Permissions Help
About...
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Feature specific help is available; from the window for which additional
information about a feature is wanted, using the F1 key or right mouse click will
bring forward more information regarding that portion of the window.

(W\ﬂrtua—ﬂmdquarlaer:—tu:tmr Support Library I.:JW
File Search Crcuation Acquisitons Cataloging Oplions Tools Window Heip

| 241 @i 4 % oo AR IN - QAOR (& Imm@
e : =Xy

l I

The MARC tab displays the complete contents of the MARC record in
the MARC view, dsplaying all tags, subfields, and indicators.,

The Window Menu tracks the order in which open Virtua windows were accessed.

W Virtua - Headquarters - Customer Support Library u@m
File Edit Search MARC Editor Circulation Acquisiions Cataloging Options Tools  Window Help |

M @iV 22 eE ABE N | QF T Co=a

Close all Messages
Default connection: Customer Support Library - staff  [8Vgy vy e ST E@Esl  Cascade Cataloging Windows

Tile Cataloging Windows

1 MARC Editor - Customer Support Library
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Original Cataloging Workflow

Recommended
Workflow Explanation
Cataloging in Virtua has enhanced user interfaces,
Select a ) . .

Workform including user-friendly MARC tag labels, pre-set
workforms, and updated fixed-field data with drop-down
menus.

v S
Create the ummary

MARC Record

A
Edit Fixed
Field Data

Add Authority
Headings

Create a MARC record using workforms
Edit Fixed Field Data (006, 007, & 008 tags)
Archive Records

Key Terms

Bib level

Fixed Field Editor
Fixed Fields
MARC Editor
MARC Labels
Masked record
Subfield
Workforms

Profiler Parameters

Generate 035: Determines whether or not Virtua
automatically generates an 035 tag for
bibliographic and authority records

Value for the 003: Sets the value of the 003 tag
for records exported from the Virtua database or
displayed in the MARC Editor

Do not update 005 tag with local field update in
authority records

Cataloging Tag Permissions: Allows you to give
specific users different permissions on different
tags or ranges of tags.

Basic Cataloging Workflow-Based Reference Guide
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Recommended
Workflow

Explanation (cont.)

InfoStation Reports

Broad Cataloging Statistics: Returns
information about Virtua’s Cataloging subsystem,
such as statistical information related to MARC
records.

Cataloger Productivity: Generates a count of
the original bibliographic records cataloged by
each Virtua user during a specified date range.
Bibliographic Record Load and Extract: lets
you . ..

Upload to the database a fixed-format or
delimited file of bibliographic information and
specify options to process the file and save the
data in the MARC bibliographic record format.
-OR-

Download bibliographic records from the
database and specify options to convert the data
from the MARC record format to a fixed-format or
delimited file.

Number of Records in Database: Counts of
bibliographic, item, holdings, and authority
records in the database based on the criteria that
you set in the report configuration.

Production of Records by User: For each user
specified, counts of bibliographic, item, holdings,
and authority records in the database that have
been created, modified, and deleted and that
meet the criteria that you set in the report
configuration.

Record Extraction Utility: Extract records in
ISO-2709 format from a Virtua MARC 21
database.

Record Modification Utility: Lets you make
global changes to records in the database.

URL Checker: Checks on the viability of URLs in
bibliographic, item, and holdings records in your
database.

Basic Cataloging Workflow-Based Reference Guide
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Add a New Record

Click on the Add New Record icon on the Cataloging Toolbar or select File
- Records > Create Record. The Create Record window appears.

Create Record -\

-~

Laok jn: | (=3 Catalog - £F El-
| Mappings 110aulab, wkrm circFly v Fi
|2 Mew Fixed Field Files acqg.wim o, wEm fi
|2 Mesw Workforms analytica.wfm carnmlab, wkm g
IO MSSawW analytich, wfm comp.wfm J
|hvalidate boak. wim complab,wim J
110au. wfm 4 Type: WFM File frn g

Date Modified: 9)25/20058 10:45 AM
< Size: 199 bytes 3

File narme: |".wfrrl
Filez aof type: |Llser WhorkFarmng [*.wim) j Cancel

Note: The directory displayed will default to the last directory viewed from within
Virtua Client.

Select a workform. The list of available workforms is as follows:

Use with MARC | Use with MARC Type of workform

Tag Numbers Labels

book.wfm booklab.wfm Bib Record - Book

comp.wfm complab.wfm Bib Record - Computer
file

map.wfm maplab.wfm Bib Record - Map

mixed.wfm mixedlab.wfm Bib Record - Mixed Mat.

music.wfm musiclab.wfm Bib Record - Music

vis.wfm vislab.wfm Bib Record - Visual Mat.

seril.wfm serillab.wfm Bib Record - Serials
record

holds.wfm holdslab.wfm Serials Holdings record

patron.wfm Patron record

vendo.wfm vendolab.wfm Vendor record

comm.wfm commlab.wfm Community Info Record

110au.wfm 110aulab.wfm Authority record

circfly.wfm Circ-on-the-fly
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Open the workform by clicking Open. The MARC Editor will appear with the
workform loaded.

@ MARC Editor - Phoenix99 E]@
[ ] [101202 0000 eng d

[ Jlew JLILT

L e [ [ ] = [
DCI'.IU‘I%D [
[ I e I ) =] [

[4]
=
=]

I

RN ENEERNEE

lg
%DDDDDDHHDDD

a WIRTUAD
|[aj Lahguage material |~ ] Monographstenn j [ Masked
<= hARC 21 Bib: Boolk Mew Record hodified

yUntitled1 /

Note: The bib level of the record and therefore fixed field editor will vary depending
on the selected workform.
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Edit the MARC Record

Click on any field to edit the contents of that field.
Note: Virtua allows you to create keyboard shortcuts for commonly used phrases.

Example: You could assign Alt+B to insert the string "Includes bibliographical

references".

Right mouse click or use the Catalog menu bar icons to cut, copy, and paste

information.

Undo

Paste

Insert Unicode Contral Character
Generate 830 Tag

Print...
Save...
E-mail...

Add Tag...
Copy Tag

Paste Tag
Paste Tag To Al
Delete Tag

Create Authority Record(s). ..

Close Record

Ctrl+Z

Ctrl+v

Ctrl+P

Shift-+Ctrl+A
Shift+Ctrl+C
Shift-+Ctrl+v

Shift+Ctrl4+D

14

Note: Virtua allows you to decide whether variable field data is in the MARC Editor
is overwritten by your keystrokes.
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e If the Cataloging Option Overwrite Variable Fields is selected in the Virtua

client, then variable field data is immediately overwritten by your next
keystrokes.

e If the Cataloging Option Overwrite Variable Fields is NOT selected in the
Virtua client, then variable field data will not be deleted as you type.

Add a Tag

Select Edit > Add Tag from the Menu bar, click the Add Tag icon , or right

mouse click, and then choose Add Tag to add a tag to a MARC record. The Add
Tag window appears.

7 hdd Tag - Phoeni... |2 B

Tag Indentification:
Enter Tag Mumber: [230

Entet Tag Indicatars l_

Tag Position:
(* Place in sorted order

(" Place after current cursar

(a4 Zancel

Enter the desired tag number in the Enter Tag Number box.

Note: The Enter Tag Indicator field will be grayed out if indicators are not used with
that tag.

Tab to, or click in, the Enter Tag Indicators box.

7 dd Tag - Phoeni... [ 2)E3|

Tag Indentification:

Enter Tag Murmber:  |245

Enter Tag Indicators W

Tag Position:

{* Place in sorted order

(" Place after current cursor

Ik Cancel
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Enter the proper indicators for the tag or leave the indicator spaces blank. If the
first indicator is blank and the second has a value, use the space bar to indicate
a blank.

Select where you want the tag placed in the record; either below the current tag
or in sorted order.

Click the OK button.

Delete a Tag

Place the cursor in the tag, indicator, or data box of the field that you want to
delete.

Select Edit > Delete Tag from the Menu bar, click the Delete Tag icon , or
right mouse click, and then choose Delete Tag. The Confirm window appears

e T

Confirm

P Are wau sure you wish b delete this rawy

Confirm that you want to delete the tag by clicking the Yes button.

Or you can delete multiple tags at once with the check boxes to the left of the
indicators. This can also be used for copying and pasting tags and the undelete
function.
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& MARC Editor - muse99 M=%
[ ] [ wtls0o00057 72 |
[ ][ooz [wRT |
[ ] [ 20070205140300.0 |
[ ] (02031951977 myu 00110 eng |
[ J[ow ][ )] [a7r-13774 |
[ M[ozo J[ ][] [1avstadas4sze ;e $14.95 |
[] [J[] [iaocmo33i0403 870910 |
[ J[oas ][ J[2] [iz 200702081403 ib YLOAD y 200211071755 \2 YLOAD |
[ J[oeo ][ ][] [12DLCcDLC \d wrw |
(e 00 e |
[ [oso J[o ][] [iakFiessip 136 |
[] ][] [ia346).73/0652 |
I:l El [1a Lane, Marc 3, |
I:l El | ta Legal handbook For small business | ic Marc 1. Lane. |
I:l E l:l | ta Mew York : \b Amacom, Yo c1977. |
[0 ][ 1] [wetsip.;\czzem. |
I:l I:l |:| [\ Includes indez:, |
I:l I:l El | ta small business x Law and leqislation, |
[] [ ][] [iavirTuaso |
|{a]l Language material Ll':m:' Monograph/Tkem ﬂ [ Masked
g MARC 21 Bib: Baok OPAC

OPAC1

Undo Changes

To undo any changes to field(s) in the MARC Editor prior to saving the record:

Right click and select Undo from the right-click pop-up menu or use the
combination shortcut keys CTRL+Z.

The contents of the last edited field will revert to the original contents.

To undo changes to previously edited field(s), select Undo or press CTRL+Z

again.

Continue until all desired fields are restored to their original contents.
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Copy a Tag Between Records

Open another record in the MARC Editor. Note there are now two tabs at the
bottom of the MARC Editor.

.
12 MARC Editor - Customer Support Library E]@
[ ] [ 08061052008 nyu 000 1eng |
[] [][] [e2007-038841 |
[ J[oz2o ][ ][] [ 1215552510: \c $33.00 |
[ J[o2o ][ ][] [w2781416552512 |
[ ] [ 1] [%&(oceLcemisessss |
[] [ ][] [\eDLC \cDLC \dBTCTA \d BAKER \d YDXCP \d ITE \d NPL |
[] [JL]  [enusd |
[] [J[] [eroea |
[ J[osz J[o][c] [es13.541222 |
[Jfoss JLI[] [eFexns |
|:| |:| | \a King, Stephen, \d 1947- |
|:| 245 El | \a Duma Key [ \c by Stephen King. |
I:l I:l I:l | \a Mew York : 'b Scribner, Yo 2008. |
I:II:II:I |'5a611p.j'-,|:25|:m. |
[ [s01 ][ ][] [emarcwveos/io/s |
|:| |:| El | \a Accident victims Y Fiction. |
I:l I:l El | \a Supernatural Y Fiction. |
I:I 651 I:I IEI | \a Florida Keys (Fla.) w Fiction. |
(a) Language material _™ | (m} MonographTtem ﬂ [~ Masked
g MARC 21 Bib: Book OPAC

\OPAC1 ,0PAC2 {

Place the cursor in the tag, indicator or data box of the field that you want to
copy.

Note: You do not need to select the text in the tag, indicator or data box. The copy
function copies the contents of the entire tag.

Select Edit > Copy Tag from the Menu bar or click the Copy icon on the
Cataloging toolbar.

Switch to the other record by clicking the Other Record tab.

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



19

Place your cursor in the field that you want above the tag that you are about to
paste.

Select Edit > Paste Tag from the Menu bar or click the Paste icon on the
Cataloging toolbar. The tag is pasted into the record.

Note: To specify subfields/data NOT to Copy into a New Editor Window, in Virtua go
to Options and then Cataloging Options. In the Copy Options tab of this window
there are two options:

e Subfields NOT to Copy into a New Editor Window - The subfields of the tags
that you specify here will not appear in a new MARC Editor window if you
choose Duplicate Record in New Window.

e Data NOT to Copy into a New Editor Window - The data contained in the
tags and/or subfields that you specify here will not appear in a new MARC
Editor window if you choose Duplicate Record in New Window. However,
the tags and subfields themselves WILL still appear.

W Cataloging Options - Phoenix01

File Cpkions ] Display Options  Copy Options | Editar Keystrc 4| *

Tags nok ko Copy inko Mew Editar Wwindow:
001 005 035 039

Subfields not ko Copy inta Mew Editar Windaow:
1002

Draka nok to Copy inko Mew Editor MWindow:

[ Automatically add defaulk library symbol when copying
fFram union, (See Other Opkions)

I Cancel
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Copy a Tag to Multiple Records

In the MARC Editor window, open the record you want to copy from, and all

the records you want to copy to.

20

Select the record you want to copy from, and right mouse click to copy the tag.

Close the record you copied from.

From any record open in the MARC Editor, right mouse click and select Paste

tag to all.

12 MARC Editor - phoenix

l=J2/es

[1[bos |
[ J[ow L]

i
[]
[]

[ 960517r19951986nyu o0
[\a 954764
[ \a 0684804441 (pbk.) : \c $12.

[]

[] [ ][] [eoLc)zsooazss

[ J[es0 ][ ][] [\eDLC\cDLC \dDLC \d GCmen

[ J[os2 J[o][o] [es13r8121220

[] [ ][] [eFeHemmeway

|:| I:l | ‘\a Hemingway, Ernest, \d 1899

|:| 245 | \a The snows of Kiimanjaro ang

|:| |:| I:l | \a 1st Scribner Paperback Fictig

|:| |:| I:l | ‘a Mew York @ \b Scribner Papel

[ [z00 [ [ ] [eis4p.;\c21em

[] [ ][] [emarciveos/oyos

|:| El I:l \a The snows of Kiimanjaro -- 4
and the radio - Fathers and sc
Fifty grand -- The short happy

[] [0][o] [\HEMsOKAZ2000

|(a) Language material L“

g MARC 21 Bib:

=
I
[y}
—t

Undo

Paste

Insert Unicode Control Character

Print...
Save...
E-mail...

Add Tag...
Copy Tag

Paste Tag
Paste Tag To Al

Create Authority Record(s)...

Close Record

Ctrl+Z

Ctrl+v

Ctrl+p

Shift+Ctrl+a
Shift+Ctrl+C
Shift+Ctrl+V

& nun,
be -

| Masked

The tag will be pasted into ALL Bibliographic records in the MARC Editor

window.

Hit the F11 key or the Save to Database icon on the Cataloging toolbar,

or File > Save to Database to save the records.
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Edit Fixed Fields using the Fixed Field Editor

Depending on how cataloging options are set in the Virtua client, you may either
edit the 006, 007, and 008 tags directly in the MARC Editor window, or have
Virtua open the Fixed Field Editor window to display a labeled workform for
entering fixed field information.

The 008 Fixed Fields

On the Cataloging toolbar, click the 008 icon @', or click in the data area of the
008 tag.

The Fixed Field Editor appears, displaying (for example) the fixed field layout for
books. The order of the display, starting in the first row and going left to right, is
as follows:

e Unique VTLS-defined fields
e Leader values
e 008 values in numeric order

Note: The Fixed Field Editor will vary according to the Type and Bib Level of the
record.

W/ Fixed Field Editor - Phoenix01
Book. 005 Fixed Fields
Lacal Lyl I_ Analyzed; ’_ Rec Stat; |Cnrrected or revised j
Archive: IW Enc Lvl: |Core el ﬂ Desc: m
Mulkipart: |NDI: specified or not appliceﬂ Dake Tps |Single,|'|:nrabable date ﬂ Date 1: W
Datez: | PIPub:  |Mew Yark (State) | st b

Audience: |Unknown o niot specified j Farm: |None of the following ﬂ Contents:

Govk Pub: |Notagnvt. publication j Conf Pub: |Notacnnference puh. j Festschr: |Notafestschrift ﬂ

Index: |Nn index ﬂ Fickion: |Fiction j Biographry: |Nn biographical material j
Lang: |English j Mod Rec: |N0t modified j Source: |Nati|:|nal bibliographic agenj
Entered: [090112 Virtus:  |20080112142 Used: |
Ok | Cancel ‘
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The 006 & 007 Tags and Fixed Fields

The 006 tag: When a cataloged item has more than one characteristic format,

such as a computer file and a book, you can code the 008 as one format and the
006 as the other.

Note: The 006 duplicates some elements of the 008.

The 007 tag: Describes additional physical characteristics of the item being
cataloged. The value in the first position (00) of the 007 determines the specific
layout to be used. For example, if position 00 has a value of a, the layout is the
Map layout.

To add a 006 or 007 tag:

Select Edit > Add Tag from the Menu bar, click the Add Tag icon , or right
mouse click, and then choose Add Tag to add a tag to a MARC record. The Add
Tag window appears.

[ hdd Tag -Phoeni... | 2)E3|

Tag Indentification:
Enter Tag Murmber;  [007

Enter Tag Indicators l_

Tag Position:
(* Place in sorted order

(" Place after current cursor

(a4 Cancel

In the Tag Number box, enter 006 or 007.
Edit the Tag Position.

Click the OK button. The MARC Editor adds the 006 or 007 tag, displaying two
data boxes and no indicator box

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



To edit the fixed fields of the 006 or 007 tag:

Using your mouse or the arrow key on your keyboard, place your cursor in the
first data box (position 00) of the 006/007 tag.

Type a value to represent the category of material for the tag. You can right

mouse to see the pop-up menu of available choices.

(a) Book,

(] Printed Music

(d) Manuscript Music

(2} Printed Map

(F) Manuscripk Map

(g} Projected Medium

(i) Mon-Musical Sound Recording
(i) Music Sound Record

¢k} 2-0 Mon-Projectable Graphic
(rm) Computer File

fa) Kit

(p) Mixed Makerial

(r) 3-D ArtiFactMatural Object
(=) Serial

(£ Manuscript Language Material

23

Click in the second data box of the 006 field. The Fixed Field Editor appears,

displaying the 006 fixed fields for the category of material selected in position

00.
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m ARC Editar - Phoenix®9 =2 I_Nl
[J[oor ] [ts0ooasszss I
[[oos ] [Faye |
[J[oos] [20070115000500 0 |
003 D4092752005  myub 000 1 erg
[ [ooe ] | I
[(Jlowo ] [e 2004022563 |
[lezo [ ][] [=osteonrmo o« ss0es |
[(Mess JL]  [e corcizoosnzesss |
[Jless J[][s] ['= 200701180005 & vL0AD \ 200506080849 'a braylor ' 200506080837 'd blaylor 'c
200503071748 'y 200503071748 'z mancarthes
% W Fixed Field Editor X
[][G | Bock 00e Fixed Fiews
L0 | ocanew: [ poatyzed: | Rec Stat: [increase from prepublicatc = |
% Archive:  |Mo specfictype = Enc Lvl: |Fullievel | ese:  [aacrz  ~
[] Multipart: | Mot specified or not sppiice v | Dete Tp: |Singleiprobable dste v | Dated: Ii-mﬁ
% Dets 2: PIPUb: | Mew York (State) ~lms b EH
Cl[] | A [Urknown orriet speciied v| Form:  [None crthe folowing »|  Contents: | B
[J[e | Govt Pubsi [raot & gowt. puhestion | Con Pubs: [ ot o conterence pub.  »|  Festsche: [notatestsenem |
% ndex: | No index B Fiction: | Fictin »|  Biography: |No biograptecel mstensl  w |
O] lang:  |Engish feng) x| Mod Rec: | ot moded w| Source: |ationai bibliographic agen |
] Entered: (040927 Vitua:  [20050307174 Used:  [20070118000
ok | caca |

008 Position: & Publication Satus

| @) Language materis x| imy morographmem | I Masked
<[> MARC 21 Bib: Book OPAC

Note: If you try to edit this field before you choose a value for position 00, the
system displays an error message. Because the fields are different for each
category of material, until the categories are defined, the system does not know
which fixed fields to display.

Edit the fields as needed, using your mouse or the Tab key on your keyboard to
place the cursor.

Click the OK button to save your changes.
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Edit Fixed Fields in the MARC Editor Window

Cataloging Options may be set in the Virtua client to allow you to edit fixed fields
directly in the MARC Editor window.

To edit a 006, 007, or 008 Tag in the MARC Editor window:

Click in the field that you wish to edit.

Move the cursor at least one space. Centered at the bottom of the MARC
Editor window, you will see information related to the fixed field position
directly to the right of the cursor.

& MARC Editor - Phoenix99 =03
[isonn253299 I
| McFayC Frz

[
=
Lig]

| 200701 15000500.0

[
=
o

DDDDDDED EEEEDDDD
EIFE] EEELE

| ta 2004022563

| e 036011770 ;e $30.95

|
|
|
| 04032752006 ryub 0001 eng |
|
|
|

| ta (DLCY2004022563

i3 2007011800005 b WLOAD W 200508030849 ' btaylor v
200506020837 W btaylor w 200803071 748 'w 200503071743 =
mrcarthu

|'IE DL DLC W GCmEBT

|12 81306 12 22

12 F 18 KOSTOWS,

—
[
(]

| 'a The historian :'b a nowvel /e Elizabeth Kostowa,

121t ed.

LO0EIEOED DO

| 'a Mew York @b Litle, Brown and Co, Wz 2005,

CICICEIO0EE =eee

|
|
|
| 2 Kostova, Eiizabeth, |
|
|
|
|

|1,aix,542p.:1bmap;1.|:24cm.

()
=
=]

=i

» 005 Position: &: Date 1

|(aj Language rmaterial |~| () Monographitemn j [ Mazked

-

MARC 21 Bib: Boak: COpAC

WOPACT

Move the cursor to the desired position and edit the record.
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Mask Record

Under certain circumstances, you may wish to set record masking so that a
particular record does not display in the OPAC. One example would be if you do not
wish items on order to display.

To mask a record, click the Masked check box on either the MARC View Editor
window or on the View Bibliographic Record window. The bibliographic record
will not display in the OPAC.

Add Authority Headings

In the MARC Editor, open the bibliographic record to which you want to add an
authority heading.

Place the cursor in the tag containing the heading that you want to search.

Select either Authority Browse or Authority Keyword from the right mouse
pop-up menu.

e If you choose Authority Browse, the Search window will open with the
Browse tab active.
_OR_

e If you choose Authority Keyword, the Search window will open with the
Heading tab active.

The Search window is populated with the information from the selected tag in the
MARC record. Edit the search string if necessary and click the Search button.
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¥ Search - Phoenix01

Browse lHeading ] Keyword ] Contral Mumber ] Patran ]

|Sul:|je|:t ﬂ |i-.-'ampires Fiction.

To begin a browse search of the library catalog,

1. Choose the type of search by clicking the arrow in the First bos,

2, Then dick in the empty boo,

3. Tvpe a whole or partial lask name, subject, title, call number or
athet entry appropriate ko the kype of search wou are doing.

4, Click the Search buktton ar press the EMTER key on wour kevboard,

LIBRARY MOTICE

Put wour customized library message here and on every other tab
af the Search window, To da khis, edit the appropriate Help strings

Location Search

Cancel

e If you perform a Browse search, the search results will appear in the

Browse window.

e If you perform a Heading search, the search results will appear in the List

of Headings window.

27

Highlight the desired term on the Browse window or List of Headings window.

Click the right mouse button to see the pop-up menu.
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W7 Browse - Phoenix01 [;]

Subject: Yampires Fiction,

Hits | Terms
[-_Eﬁm.:-_m m___.j

119 Vampires -- Fiction|  What's This?
1 |Vampires -- Fiction
1 |Yampires -- Fiction,  Next Search Ctrl+Tab

1 ¥ampires -- Fiction|  preyious Search Shift+Ctrl+Tab
1 Vampires -- History

7\vampires in lkerat New Search
1 Vampires in iteraty :
1|vampires in fiteraty  “oPY He‘"d"fq Qr+C
1 |Vampires -- India -/  Merge Heading Crl+v
View Authority
Add Autherity to Editor
Replace Heading in Editor
Copy

Print... —
Subject: Yampires Fiction. r Save..,
E-mail...
View et S T - Delete

If desired, choose View Authority to view the authoritative heading on the
authority record.

Note: In the case where the heading on the Browse window is a See reference or
an AAP title, the Add Authority and Replace Heading options will be disabled.
Instead of clicking either of those options, choose View Authority. On the View
Authority Record window, navigate to the record with the desired heading, right
click, and then choose either the Add Authority or Replace Heading option.

Choose Add Authority to Editor or Replace Heading in Editor.
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The Add Tag dialog box appears.

7 hdd Tag - Phoeni... |2 5|

Tag Indentification:

Enter Tag Mumber; |650]

Enter Tag Indicators l_

Tag Position:
(* Place in sorted order

(" Place after current cursor

(a8 Cancel

Enter relevant data in the Add Tag dialog window such as tag number,
indicators, position, and click OK.

e If you selected Add Authority to Editor, the valid authority heading was
added to your record in the specified tag in the MARC Editor.
_OR_

e If you selected Replace Heading in Editor, the valid authority heading
replaced the existing heading that your cursor is on in the MARC Editor.

Note: Virtua allows one authority record to be used in the following manner:

1) As both a name and subject. If the 008/14 and 008/15 are both "aa" and
the 1xx tag is 100, 110, or 111, the authority is used as both an author and a
subject.

2) As both a title and subject. If the 008/14 and 008/15 are both "aa" and the
1xx tag is 130, the authority record is used as both a title and subject.

Authority Control Headings Suggestions

Suggested authority control headings may be viewed while a bibliographic record is
edited on the MARC Editor window. This workflow is available for the following
UNIMARC and MARC21 tags: 1xx, 6xx, and 7xx.

To view suggested authority control headings:
Position the cursor in the tag data area of an eligible bibliographic record tag.
Press Shift + Ctrl + S to display the Heading Suggestion window.

Valid headings whose lead characters match those entered in the tag data appear.
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\a Bu |Elutter|ies {DLC}

‘a Me|| |Butterfies {DLC}

Butterfies as pets {DLC)

Butterfiies as pets — Juwenie iterature.

‘a Ok ={Butterfies — Behawior.

Butterfies — Canada, Eastern.

Butterfiies — Coler — Juvenile iterature.

‘a Inclug Butterfies — Comic books, stnps, eic.
Butterfiies — Dewvelopment — Juvenile Rterature.
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‘a MARCTVEUSU o

‘a Photographs and text explore the behavior and ife cydles of butterfies and moths, examining
mating rituals, camouflage, habitat, and growth from pupa to larva to adult.

|".EI Butterfies w Juvenie iterature

|'-,£| Maths W Juvenile literature.

|'-,£| Butterfies
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Select a heading from the list.
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|'-z| DK eyewitness bocks
|'-z| Onginally published: New York : Knopf, 1988, (Eyewitness books).
|'-z| Includes index.
| ‘a MARCIVE 03/01/06
‘a Photographs and text explore the behavior and ife cycles of butterfies and moths, examining

mating rituals, cameoufiage, habitat, and growth from pupa to larva to adult.

|'-z| Butterfies w Juvenie literature

| ‘a Moths w Juvenile iterature.

|'-z| Eutterfies

[ & Moths.
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[ 12 vIRTUAS0
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MARC 21 Bib: Book

j [~ Masked
OPAC | Modified

5
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[y}
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Click OK to add the selected heading to the tag that is active in the MARC

Editor window.
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|'-.a Butterflies w Juvenile iterature.

| ‘a Moths w Juvenile iterature.

| \a Butterfiies ‘x Behavior.
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Record Validation

Recommended
Workflow

Explanation

Validate MARC
Format

Fix Errors in
MARC Format

A
Validate
Against MARC
Record Rules

l

Fix Errors in
MARC Record

\ 4
Validate
Authority
Records

y
Fix Authority
Errors

Virtua validates MARC records in several ways based on
options set in the Virtua Client and parameters set in the
Virtua Profiler. The following types of MARC record
validation are available:

1.

2.

3.

VERICAT: MARC format validation available in the
Virtua Client.

Record Validation Rules: Pre-defined MARC
rules in the Profiler that can be set to Off, Warn,
or Error state.

Authority Messages: Four parameters in the
Profiler that define how authority records and/or
informational messages are handled.

Summary

Validate a record using Vericat

Understand Record Validation options in the
Profiler

Understand Authority Record parameters affect
how bibliographic records may be changed by the
system when saving a record to the database.
Understand record validation messages

Key Terms

Error State
MARC Editor
Validation Rules
Vericat

Profiler Parameters

Record Validation Rules

Authority Messages
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Record Validation Using VERICAT

VERICAT is a program available with Virtua that validates records based on MARC
format rules for tags, indicators, and subfields. It is possible to edit the Vericat
rules files to reflect local practices. If you have VERICAT installed on your
workstation, there are two ways in which you can validate Bibliographic records
prior to saving them:

1. From the Edit Menu when the MARC Editor window is open
2. When saving a MARC record to a file or database if the appropriate
Cataloging Options are set.

Note: UNIMARC validation is supported.

Use VERICAT from the Edit Menu

Select Edit - Validate Record or the Validate Record icon on the
Cataloging toolbar to validate the record displayed in the MARC Editor.

W/ Virtua - Headguarters - phoenix g@

Circulation  Acquisiions Cataloging Options Tools Window Help

E admEg N - 90X & «||aDbB B &

File ' Edit Search MARC Editor
2
Defal
Add Tag... Shift+Ctrl+A
Copy Tag Shift+Ctrl+C
Paste Tag Shift+Ctrl+v

Paste Tag To Al

Validate Record

| 960517r19951986nyu

[ 15 25-4764

[ \a 0634804441 (pbk.) : \c $12.00

[\a (DLC)25004764

g " | | B

[\ DLC \cDLE \d DLC \d GCmET

[ [zs2 J[o][o]
[ [ess JLIL]
[ J[ao J ][]
[IC]
LIC]
[IC]
LIC]

[]
[]
[]
[]
[]
[] [o][]

[¥5)
] ][22
(=] (=]

8131912220

[\a F \a HEMINGWAY

| ‘& Hemingway, Ernest, \d 1892-1951,

| ‘@ The snows of Kiimanjaro and other stories / \c Ernest Hemingway.
| \a st Scribner Paperback Fiction ed.

| 'a Mew Yark : \b Scribner Paperback Fiction, ‘o [1986], 1995,

[\a 154p. ; \c21cm,

[ \a MARCIVE 03/01/06

‘& The snows of Kilimanjaro — A dean, welHighted place — A day's
wait - The gambler, the nun, and the radio -- Fathers and sons — In
another country - The killers -- A way you'll never be -- Fifty grand --
The short happy life of Francis Macomber.

||:a) Language material ;ll:rn) Monograph,Ttem ﬂ [~ Masked
< = MARC 21 Bib: Book OPAC
“OPAC1 /

When the validation program finishes checking for any rules violations, a window
appears listing any error messages from the rules file.

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



34

To print, save, or e-mail validation errors, perform a right mouse click from the
Record Validation Errors window to bring up the pop-up window for these

options.
o ibhographic Record - Ph 1 -
_]_| 11 Record is in state: Error
Fl | marc |
. The best chment [ edited by Ken
Tide: Shelton, | o Messages - Phoenix01 E]@E .f o
15E8: 05853552
- 173p. :g| | Record Update failed
caon, 1z | [Vorro sstsssno sk posenr
) Srrng: N User per v her i
IPubiication: Prove, Wl | £ ecutive Excelence Pub.,

Subject - bopical:  Se¥-mped| | Frror: Conflict exdsts as 4300 07—

Subject - bopical: personal {| | Error: Server load error message  What's This? Licar.
; ck g 4
Subject - bopical: Electroniq| | Conflict exists & 4xx —
Added Entry: Shelton, § .
Added Entry: [t b ar] Em&--
Date (vyyymmdd):  2009021% s —
Anahytics: DSE53555
Unsatisfind Requeshs: o
Totsl Requests: 0
[~ Maskad : | et | Requesteb | addmem |  mefresh | close |

Note: If you select Copy, you have to highlight what you're copying in order for it
to paste somewhere. It doesn't automatically select the whole message.

Once Validation is complete, click the OK button to return to the MARC Editor
window.

Correct the errors in the record.

Click the Validate Record icon again. If the validation program finds no errors,
Virtua prompts you that the record is valid.
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| 960318r19951940nyu 000 1eng
[ \a 367705

[ \2 0654830485 \c $30.50

[ \a (OCoLC)oem34475606

[ \a DLC \cDLC \d HOB

| \a e-sp—

Ll HoBa | Information
| \a F HEMII \]::) The record is valid.

| ‘a2 495 p. ; e 29 om.
[ \a MARCIVE 03/01/06

WEY.

L

| \a Spain ‘w History Yy Civil War, 1936-1332 w Fiction,

| 'a War stories. \2 gsafd

913 | \a HEMPWTBS8000
994 [ \a E0 b HOE
|{a} Language material L' {m) Monograph,/Ttem j [ Masked
< | = MARC 21 Bib: Book QOPAC | Modified
OPALCT

Use VERICAT by Setting Cataloging Options

The Virtua client will automatically perform a MARC record format check when a
MARC record is saved to a file or to the database under the following conditions:

e If VERICAT is installed on the workstation

AND

e If the appropriate validation options are checked in the Cataloging Options

window.

Note: If you set up VERICAT to automatically validate records, all MARC format

35

errors must be fixed before Virtua will allow you to save the record to the database.
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W Cataloging Options - Phoenix01

Copy Options | Editor Keystroke Mappings  ©ther Optians I 1 | "l

alidation Options

v Validate when Saving o File
v Walidate when Saving ko Database

[ ise Specific Bibliographic Rule Files:

v Show Delete Warnings
|V Edit 008, 007, 008 in Editar
[~ Owerwrite Yariable Fields
Biblingraphic MARC Format

[~ Mask Mew Records
[~ Use Multiple Editors

Huoldings Spine Label subfields

|MaRcC 21

=

Default Library Symbol

(0] 4 I Cancel
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When a MARC record is saved, Vericat checks for errors. If errors are detected,
a message will appear in the Record Validation Errors window.

A right mouse click on the Record Validation Errors window allows you to
print, save, or email the errors.

W View Bibliographic Record - Phoeni nE %
e e N Record is in state: Error
Ful | manc |
: Il Chmert | dted by Ken
1+ sm.u-.J W Messages - Phoenix01 E]@ ! by
1SEN: 0565355 =l
iption: 173 p. : @] | Record Updabe: Failed
E:::tﬂ" !St:i Warring: Subfield data is duplicated: 040 4o NET
" Warrirng: Mo user permanent suthorty for heading: 260 §b
Publication: Provo, LB| | . ecutive Excelence Pub.,
Subject - topical Self-irprs| | Error: Conflct exists as 4300 0= _—
Subject - topical:  Personalif | Error: Server load error message  What's This? e
Subject - bopical Electronid Conflict exdsts 8% 4xx —
Added En : heilib il Sane...
: : Ernad. ..
Dt (yyyymmdd): 20090215
Analytics: QSES3SES
Unsatisfied Requests: i}
Total Requests: o
I Masked Edt Request Bb Add Ttem Refresh Close
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Messages When VERICAT Is Not Installed

If you try to use VERICAT and the program has not been installed on your
workstation, the following messages will appear prompting you to search for the
program.

The Confirm window will display a message prompting you to look for the
program.

x|

9 | The validation executable (Wericat.exe) could not be found. Wiould vou like to look for it? (Wote: You may have
‘-‘/ chosen not to install it when vou installed the Virtua client. I so, you need to run the client install again and
choose to install the validation executable when asked.)

If you click the Yes button, Windows® will open the standard browse window so
that you can navigate to the VERICAT program. It is typically installed under:

C:/Program Files/Vericat/Vericate.exe

In addition, the Record Validation Errors window will display a message stating
that the VERICAT program could not be found.

¥ Record Validation Errors - Port - 10| x|
The required validation executable is not found: ;l
Wericat exe

Rule File Lsed: WTLSEIR, WAL Ok |
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Record Validation using Profiler Settings

When MARC records are saved to the database, the Virtua server performs two
types of data checks based on parameters set in the Virtua Profiler. Unlike
VERICAT, which is a program installed on individual workstations, the parameters
set in the Profiler reside on the server and affect ALL records saved to the
database.

Record Validation Rules

Virtua checks the validity of MARC record data based on the bibliographic record
checks listed in the Record Validation Rules parameter in the Virtua Profiler.
Depending on the Action set in the parameter, if the system detects an error, it
will:

e Off: Do nothing
e Warn: Display a diagnostic message
e Error: Put the record in Error state

P ]

Record Validation Rules
Rulz D | Yalidation Rule Action ﬁ
100007 Subfield reqguired: 010 ' WWarn j
100008 Yalid LGCH: 010 ' oft

fNarn
100009 “alicd LOCK - Prefix: 010 ' Error
100010 Walid LECH - Hyphen: 010 ' Errar
100041 Salid LCCH - Digits: 010 Error
100012 1=BM Yalid - Mumetic: 020 ' Warn
100013 15BN Yalid - Check Digit: 020 WyErn
100014 I=BM Yalid - Mumeric: 7B 'z Warn -
Helg Save Cancel
LastMadified at 1/27/2009 11:45:45 AM by Rook User
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Authority Messages

39

The server also performs checks related to authority headings. These are based on

the settings in the Authority Messages parameter in the Virtua Profiler.

¢ Authority Message: Can be set to report headings that do not have a

permanent authority record

¢ Heading Replacement Flag: Can be set to automatically correct possible

duplicate headings.
¢ MARC Heading Conflict Flag: Can be set to automatically replace 1xx tags

in the bibliographic record with the correct authority heading when the 1xx
tag in the bibliographic record is an existing 4xx tag (see reference) in an
authority record.

¢ New Heading Message: You can determine which tags will generate a new

heading message when authority records are created in the database.

Authority Messages will appear in the Messages window when a record is saved to

the database.

L) i
J1 JE3 BYE
Full | tems MARC |
L0 01234cam a22| . me=
o Messages - Phoenix01 | [ |
001 mﬂmll '—l'—'-
003 NeFayC Warning: Mo subject permanent suthority for heading: 650 $a &
00902 <| | Vampires §v Fiction.
g e Warning: Duplicate LOCN 010 $5 2004-022563
008 U901 1252005 || | wiarning: Subfield data is duplicated: 040 £ DLC. N0 4 DLC
oo & 2004-02256| | 'Waming: !:ﬁh: permanent aut  What's This? 00 $a
Kostiowa, th.

020 a 0316011770 Waening: No user per rt suth Print... 46
035 \a 13730921 Litte, Brown, Save. .
3% 4 2000021913 | Waming: Possible duphcste user bt Emad
40 }a OLC e ioLc
050 0 0 YaPs361l.074
082 00 lasl3lel2Ez
00 1 \& Kestova, Elizabeth.
245 1 4 s The histoeian : b & novel | \c Eizsbeth Kostova.

 Masked | et | Requesttb |  Addmem |

Messages can be printed, saved or emailed from the right mouse click pop-up

menu.
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Print, Save or E-Mail the Record

Recommended
Workflow Explanation
Print a MARC Virtua allows MARC records to be printed, emailed, or
Record you can save your record several ways. You can:
e Save it in textual format
- 4 e Save it to the database (F11).
Email a MARC e Save it as a new local file
Record e Append it to an existing local file of MARC records
v In addition, depending on permissions and/or
Save to the parameters set in the Profiler, you may be able to:
Database )
e Archive records
o Delete records
Y e Un-delete records
Save to a
Local File Summary
l e Print a MARC record
e Email a MARC record
Append to a e Save MARC records a humber of ways
Local File e Archive a MARC record
e Delete a MARC record
v e Un-delete a MARC record
Delete a T
Record Key Terms
e MARC Editor
0D ‘I' : Profiler Parameters
nReSOide a e Allow Undelete for MARC Records
e Archive Bibliographic Records flag
Archive a
Record
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Print, Save, Email, MARC Records

From the View Record window, the MARC Editor window, and the Statuses tab,
you can right mouse click to print, email, or save the contents of the record in three
possible formats.

e List of Titles
o Full
e MARC
Note: Do not confuse this Save function with the Save Record or Save to

Database functions, which saves the record in the 2709 MARC communication
formats.

Print the Record

To access the Print function, from the Full, MARC, or Statuses tab:

Right mouse click and choose Print on the pop-up menu.

The Print Dialog box appears:

Print - Phoenix01

Prinking

Bibliographic Records

Format: List of Titles ﬂ

Range Copies

J Nurnber of copies: 1 ﬂ
-

Printer Setup QK | Cancel |

In the MARC Editor, you can choose to print information in three textual
formats: Full, MARC, or List of Titles.

To print more than one copy of the document, choose the number of copies in
the Print window.

Click the OK button.

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



42

E-mail the Record

To access the E-mail function, from the Full, MARC, or Statuses tab:

Right mouse click and select E-mail from the pop-up menu or select File - E-Mail
from the Virtua main menu.

The E-mail Records dialog box appears:

L Ty
W E-mail Records - Phoenix01
Record Information Range
Biblingraphic Records (%
Forrnat: |i_ist of Titles ﬂ f"

[~ Map to ISO-8859-1

Message information

Send To; |

Subject: |

If wou do not Fill in the above information, wour e-mail software will prompk vou to
fimish composing the message when you press O,

(0] 4 Cancel

Select the Bibliographic Records Format you wish to e-mail.
Enter the e-mail address of the recipient in the Send-to text box.
Enter a subject line for the e-mail in the Subject text box.

Click the OK button.

Save the MARC Record in Textual Format

To access the Save function, from the Full, MARC, or Statuses tab:

Note: Do not confuse this Save function with the Save Record or Save to
Database functions, which saves the record in the 2709 MARC communication
formats.

Right mouse click and choose Save on the pop-up menu or select File > Save
from the Virtua main menu.

The Save Record dialog box appears.
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-

Save Records @ -\

Savein: | ) Vituad3_5 - £k Eg-

I Catalog W circhack enc
|[CiCETables 9 CircBack, enc
|hMew Acguisitions Files distributionprink, utF BN
~fE24C kmp engoodprintcancelpao, ukf &N
~fE247 tmp engcogprinkpo, ukf en;C
@ centre_codes-country_codes_uc engcogprinkporush, ukf Enc
e |
Save as type: | List of Titles | Cancel

Enter a file name and click the Save button.

Save Records in MARC Format

Save the Record to the Database

Click the Save to Database icon , press the F11 key, or select File > Save
To Database from the Virtua menu bar.

Note: When a new record is saved, a bib-ID is system-assigned. This control
number, which is used primarily to track a library’s check-out history, is displayed
in the 001 tag with a “vtIs” prefix.

The record is saved immediately to the database, and the View Record window
appears displaying the MARC tab view of the record you just edited.

Note: When the record is saved to the database, VERICAT and the record
validation parameters set in the Profiler may be used to validate the record. Error
and/or informational messages may appear and depending on your settings, you
may need to fix errors before the record will be saved.

Save Record as a New File

Select File on the Virtua menu bar.

Choose Save Record As. The Save Record As window appears.
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Save Record As...

e

Save in: I I Catalog

> = B ek E-

|5)Mappings labels, rec
|- Mew Fixed Field Files MARCOuUmp, rec
I Mew Workforms Moore, Fec

simplelabels.rec

verghese, rec

IS onan.rec

Iy validate samplelabels.rec

jgreen,rec SavedCopies.rec

Fil= name: |“.reu: Save

Save az bype: IFIeu:u:uru:Is [Frec)

LI Cancel

Help

Pk

Select the appropriate directory (the default directory will be where you saved

the last file).

Type the *.rec file name to save to in the File name textbox.

44

Note: if you save MARC records without adding the extension, Virtua adds the .rec

extension.

-

Save Record As...

ax]

> & @ o E-

Iy Cakalog MMEYEr, FeC
| DETables TN Fec

I)Mews Acquisitions Files ocle.rec

Bushnell. rec picw e
erb.rec pEwWrEn, Fec
hosseini.rec rand.rec

viroblewski, rec

File name: Iknstnva.rec

Save

Save as ype; IHEEDrdS [*.rec]

LI Cancel

Help

Pl

Click the Save button.
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Append Record to an Existing File of MARC Records

Select File on the Virtua menu bar.

Choose Append Record To. The Append Record To window appears.

-

Append Record To...

B[]

|[C)Catalog MIEYEr, FEC
|[C)DETables MUn, Fec
|y Mew Acquisitions Files oclc.rec

Bushnell.rec pw L FeC

erb.rec PEMFET FEC

hiosseini, rec rand.rec

File name: *rec

Save as lype: | Records [*.rec) ﬂ

x| & Bk E-
wroblewski, rec

Save

Cancel

Pl

Help

Select the appropriate directory (the default directory will be where you saved

the last file).
Select an existing local file to append to.

Click the Save button.
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Delete Bibliographic Records

Users with proper permissions can delete a bibliographic record from the database.
Search the OPAC for the record to be deleted.
Display the View Bibliographic Record window.
Click the Edit button. The record appears in the MARC Editor.
Go to File > Delete Record from Database on the Virtua menu bar.

A Confirmation window appears:

e m

Confirm

P Are wou sure you wank to delete this record from the database?

-

...........................

Yes | Mo Zancel |

Click YES to confirm the deletion.
Note: You cannot delete a bibliographic record from the database if item records
or holdings records are attached to the record. For union catalog users, Virtua also
prevents the deletion of a bibliographic record if it contains a library symbol.

Note: You are able to delete bibliographic records with Acquisition status tabs.
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Undelete Bibliographic Records

If the Allow Undelete for MARC Records option is turned on in the Virtua
Profiler, users with proper permissions will be able to undelete MARC records in
record state Deleted.

Profiler Tip: If the Allow Undelete for MARC Records option is turned off,
records are deleted immediately from the database and CANNOT be recovered.
The default setting is off. See Setting the Cataloging Basic Options Parameter:
About the Allow Undelete for MARC Records Setting in the Virtua Profiler/Cataloging
Parameters User’s Guide for more information.

To undelete a record in the Virtua Client:

Select Search by State from the Search pull-down menu on the Virtua client
main menu.

Select Deleted Records as the State on the Search By State window.

Search by State - Phoenix01
Find records of type: |Bi|:| j
[ System ID: |
v In stake: |Deleted ﬂ

Delsked
[ Cataloged by user: Errar
Becky's State

[ With a bib level in:

[ With a type in: |

| Imparted From file: |

[ Walidation Rule Mumber: |

Cataloged on or after: ﬂ
Cataloged on ar befare: ﬂ
Search Cancel |
Click the Search button.
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The Records by State window will appear.

W Records by State - Phoenix01

BEX

Murnber of state records Found:

31

4n AnmAETAra daddelanne | Lo E8

|Recnrd jin] |Date |User State
1 000287257 |2f15/2008  staff Deleted
2 O00zerzrz |4i7iz003 skaff Deleted
3 000287286 |5)7/2008 staff Deleted
4 000287287 |5i7iz2003 skaff Deleted
5 O00zE7zes |5i7iz2003 skaff Deleted
6 000287296 |S5)22/2008 | staff Deleted
¥ 000287305 /3002003  staff Deleted
& 000257306 |S5)3002003  staff Deleted
9 000287332 |7f1/2008 staff Deleted
10 000257436 |10/302008  staff Deleted
11 000287436 |10)3/2008  staff Deleted
12 000287439 |10)3/2008  staff Deleted
13 000257446 |10f15/2003 staff Deleted
14 000287447 |10J13/2005 staff Deleted
15 000257449 |10/15/2008 staff Deleted
16 000257450 |10/15/2003 staff Deleted
17 000287451 |10J15/2005 staff Deleted

Feoloiod

LOR
ol
o3
oS
QoS
039
100
999
999

00253nam 42200121 & 4500
vHsO00267447

MeFayC

20051013152600.0

051013 0o00engd

Yy 200E10131526 Y2 staff

‘a jones, martha

\a WTLSSORTODE0* 1000%39391
\a WIRTUA4D

Warning: Authority deleted: 974944 - Author: jones, martha

Edit

Delete ‘ Close |

Select the record you wish to undelete.

Click the Edit button to bring the deleted record into the MARC Editor.

Press F11 to re-save the record to the database.
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Record States

Recommended

Workflow Explanation
To aid your library or union catalog in the management

Set Record of cataloging tasks, Virtua offers a feature called record

State state management. Record states allow your library to
create and assign flags or states to records to specify
l how these records are viewed, stored, or edited.
Search by The software supports record states for:

Record State

v
Change
Record State

e Authority records
e Bibliographic records
e Patron records

The software does not support record state for
e Holdings records
e Item records

In a future release you will be able to generate a report
using InfoStation® that describes the status of records
in a given state in the database.

Summary

e Set Record States
e Search for records in a given state.

e Set the record state as a load option in the Client.

Key Terms

e Load Options
e Record States
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About Record States

Virtua allows the user to assign states to cataloging records as they are saved to
the database. The following states are available:

Two states are system assigned and cannot be edited or deleted:

e Error: Indicates that the record has not been completely processed because
of some error that the system encountered. The record must be corrected
and reprocessed.

¢ Process Immediately: The record is saved directly to the database and
does not have a record state assigned.

Six states can be edited or deleted in the Virtua Profiler. The record states that
come with Virtua are:

Review 1: First level of the review process

Review 2: Second level of the review process

Review 3: Third level of the review process

Review 4: Fourth level of the review process

Overnight: Record will not be processed immediately upon being saved to
the database. Instead, a program executed during the evening will process a
batch of records together.

¢ Wait: Indicates that the cataloger of the record is not currently working on
the record, but intends to come back and finish it later.

Additional record states may be added in the Virtua Profiler:

For example, you might want to review the work of a junior cataloger. You can
create a record state with their name and assign a senior cataloger to review their
work. Once the work has been reviewed, the senior cataloger can save the records
to the database.

Profiler Tip: You can define record states, edit or delete the default states, and
define additional states via the Record States parameter. See Configuring Record
States: Working with the Record States Parameter in the Virtua Profiler/Cataloging
Parameters User’s Guide for more information.
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Setting Record States
Select Options > Load Options from the Virtua Main menu.

Click the General tab.

Load Options - Phoenix01

General l Bibliographic {and Community Info) | Authority | Holdings | Patran |

[~ Character Set: | -]
[ Date Entered Flag: | |
[~ Load Options File: |

¥ Record State: |Process immediately =]

Becky's State

| oK Cancel

Click the Record State check box to enable the drop down and select one of the
options.

Click OK. All records saved to the database from the configured workstation
will be saved with the selected state. This setting is persistent and will remain
in effect on this workstation until changed.
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Search by Record States
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Select Search > Search by State from the Virtua main menu.

o Virtua - Phoenix01

=E x|

File Search Croulstion Acquistions Options Tools ‘Window Help
+{) IR Wl abB

=E;T

j: S e

s BR CL | & W Tl IR

Dafai, Fuutheor
= Tite Fa

Current connection: Phoenix0l P

Subject
Call husnbier
Patron Nafne Fa

Kesword

15BN

IS5N

LCCN

[Patron Barcode
Ttem Barcode F3
155N Serisls Fi0
Serial Abbreviation

Instruchor
Course ID

Select a record type, such as bibliographic records, from Find records of type.

Click the In State check box to enable the drop-down list.

Select a type of state such as Deleted.

"Search by State - Phoenix01
Find records of type: |Bib -]
[~ System ID: |
¥ In state: Deleted -]
[ Cataloged by user: rm@

I™ With a bib level in: ]Eecws e

™ with a bype in: [

I Imported From File: |

[~ validation Rule Number: |

Cataloged on or after: I =

Cataloged on or before: |FI : |
Search Cancel |

Basic Cataloging Workflow-Based Reference Guide
*Updated to 16.1

Last Revised: October 2017



Click the Search button. The Records by State window will appear.

W Records by State - Phoenix01 g@
Nurnber of state records Found: 31
|Recc-rd 1D | Date |User Stabe |

1 000287257 2/15/2008 staff Deleted

2 000287272 4/7/2008  staff Dieleted

3 000287286 5/7f2008  staff Deleted

4 000287287 5/7/2008  staff Deleted

5 000257283 S5/7/2008  staff Dieleted

& 000287296 5/22/2008  staff Deleted

7 000287305 5/30§2008  staff Deleted

8 000257306 5/3002008  staff Dieleted

9 000237332 7/if2005  staff Deleted

10 000287436 10/3/2008  staff Deleted

11 0002587433 10§3/2008  staff Dieleted

12 000237439 10y3/2005  staff Deleted

13 000287446 10/15/2008 staff Deleted

14 000257447 10/13/2008 staff Deleked

15 000237449 10152008 staff Deleted

16 000287450 10/15/2008 staff Deleted

17 000287451 10f15(2008 staff Deleted =

Edit: | | Close |

From the search results, select the record to edit. A view of the MARC record will
appear on the right side of the window.

W Records by State - Phoenix01 g@
Mumber of state records Found: 31
|Record 1D [Date |user Shate | |Lor 002€5nam 42200121 4500

1 000287257 2/15/2008  staff Deleted =/ |oo1 L“;”D?:za?z?z

2 hOnzETRTE 4i7io00s  staff Deleked ; ggg 25025 w07 1623000

3 000287286 5(7/2008  staff Deleted 008 - 00 eng
4 0002587287 5/7/2008  staff Deleted 039 g v 200804071623 |z staff

S 000257288 S/Ff2003  staff Deleted 100 Ya oconnell, tom

6 000257296 5/22/2008  staff Deleted 245 1 title

7 000257305 5/30/2008  staff Deleted 729 o HIRTLFERS

8 000287306 5/30j2008  staff Deleted

9 000287332 F/1/2008  staff Deleted

10 000267436 10/3j2008  staff Deleted

11 000267438 L0Of32008  staff Deleted

12 000287439 10/3j2008  staff Deleted

13 000267446 10/15/2008 staff Deleted

14 000267447 L0f13(2008 staff Deleted

15 000287449 10/15/2008 staff Deleted

16 000267450 10/15/2008 staff Deleted

17 000267451 10f15/2008 staff Deleted -

Edit | Delete | Close |

Click Edit to bring the record into the MARC Editor.
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Errors When Saving MARC Records

If an error occurs that prohibits you from saving a record to the server (e.g.
1xx/4xx conflict), the record is removed from the MARC Editor and it is placed in
Error State.

Note: One common reason for records in error state is a 1xx/4xx conflict. When
a bibliographic record is saved to the database, Virtua identifies all terms (e.g. 6xx
tags) in the bibliographic record as valid headings and either links the bibliographic
record to an existing authority record (via the 1xx tag of the authority record) or
creates a new authority record with the term in the 1xx tag. But if the same term
exists in another authority record as a 4xx tag (see reference), then Virtua cannot
create an authority record for the term in the incoming bibliographic record. A
1xx/4xx conflict exists because the same term cannot be both a valid heading (1xx
tag in an authority record) and an invalid heading (4xx tag in an authority record).
For more information on 1xx/4xx conflicts see the Cataloging: Configuration and
Authority Control Training Manual.

To correct the record:
From the Virtua client, select Search > Search by State.
Select a record type from the Find records of type dropdown.
Click the In State check box and select Error from the dropdown.

rSearch by State - Phoenix01 -\

Find records of tvpe: |Bi|:| j

| Syskem ID: |

<]

[v I skake:

[ Cataloged by user:

[ With a bib level in:

[ with a type in:

[ Imparted From file:

[ Malidakion Rule Mumber:

Cataloged on or after:

[
[

Cataloged on or before:

Search Cancel |

Limit the search by a date range (optional).
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Click the Search button. The Records by State window will appear.

BEX]

W Records by State - Phoenix(1
Murber of state records Found:
|Rec0rd jin] | Date |User Skate
1 000001128 4/8/2008 rock Errar
2 000001754 4f8/200& rock Errar
3 000001755 4f8/200& rook Error
4 000001756 |6/5/2008 skaff Errar
5 000001757 4f8/200& rock Errar
6 000001854 11f19/2008 root Error
7 000003425 [11§19/2008 rook Errar
8 000003604 11/19/2008 rook Errar
9 000003605 11f19/2008 root Error
10 000003703 (11§19/2008 rook Errar
11 000003385 11/19/2008 rook Errar
12 000004304 | 11f19/2008 root Error
13 000004555 (9f25/2008  root Errar
14 000004556 2f19/2009  staff Errar
15 000005032 972502008 root Error
16 00000SS76 | 11§19/2008 rook Errar
17 000005644 | 11/19/2008 rook Errar
P P P Y SO p .

LDF. 03536ngrm a22007331a 4200 -~
o1 wtls000003605
o5 McFayC
0os 20081119111300,0
a7 d cvaizk
nog 03051252003 xxul0S g vleng d
0z0 \a 075654206 o $34.99
oze 4 2 1a29125%b Touchstone Home Entertainment
035 Ya (OColClocmS2220430
037 \b Midwest Tape in http: vy, midwesttapes.com
039 g a3 200811191113 b YLOAD Yy 200406232004 |z load
040 Ya TEFMT ‘¢ TEFMT 'd TEF
041 1 'a enga fre \b eng th eng
g2 0 4 lav9l4sfFzizal
099 la 791,4372 \b BRINGIMNG DOWN THE HOUSE
245 0 0 aBringing down the house \h [OVD videorecording] [ e =
Trwrhebana Dichiivas rracanbe o Mawid Hebaernan ! fchnl
Home Enkertainment ; $b Distribubed by Buena Vista Home -~
Entertainment,
‘Warning: Possible duplicate user heading: 260 $b Touchstone Haome
Entertainment ; $b Distributed by Buena Yiska Home Entertainment,
Error: Conflict exists as 4xx: 0 $a Lawyers $v Drama,
w

Edit | Delete | Close |

Note: The bottom right corner of the screen may contain information about why

the record went into Error State. If it does not, you may need to run the
Cataloging Errors InfoStation Report to identify the error.

Select the record and click the Edit button to bring the record into the MARC

Editor.

Correct the record and save.

Delete State Records

From the Records by State window it is possible to delete records that are in a

record state.

Select the record that you wish to delete. The MARC record will appear in the

right-hand window.

Click the Delete button.

55

e If the record was an existing record in the database, the record will revert to
the original.
e If the record is in error state record with no base record, it disappears
entirely.
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W Records by State - Phoenix01 E]@|
Humber of stabe records found: 516
|Record D [Date  Juser |seate LR 03536ngm a22007331a 4500 ~
1 0001128 4/8f2008  root Errer 001 w
50000 008 003
2 175 (A root Errer 00s 20081119111300.0
3 000001755 4/6/2008  root Error s Tmreri
4 000001756 6fSf2008  staff Error 00a 03051252003 xxul0S g wieng d
S 0000017ST 4/82008  root Errer 020 Ya D7B334296) |c §34.59
& 00000184 11/19/2008 root Errar 028 4 2 1829125 b Touchstone Home Entertainment
035 \a (OColC)oomS2220430
7 OOOO03425  11/19/2008 root Errar
s 3604 1119 ok e 17 b Micdweest Tape | hittp:ffemaw. midwestt apes. com
006 /2006 ror 039 9 \a 200811191113 b VLOAD Ly 200406232004 |z load
9 000003505 11)19)2008 roob Error 040 Ya TEFMT \c TEFMT id TEF
10 000003703 11/19/2008 root Error 041 1 14 eng 1a fre \b eng th eng
11 CO000EES  11/19/2008 roat Errar oz 0 4 la7el43TZIZ2L
12 000004304  11/19/2003 root Error 099 :aﬁl.mmminmn{:mwmm mn
13 000004555 9J25/2008  root Error 295 00 TN com L L ki | [
B 000004556, 2/15/2009 | scaf¥ Error Home Entertainment ; $6 Distributed by Busna Vista Home ~
15 (OO0S08Z 9J25/2008 root Error Entertainment, - -
wml aba Lar 5 Hicermes:
16 COOO0SSTE  11/19/2008 roat Errar Emmmm’m; thmoml ME“‘“E “”"E eSO '
17 000005644 11192008 root Error Error: Conflict exists as 4%%: 0 $a Lawyers $v Drama, )
PR P — i v
e

Change Record States

Select Options 2> Load Options for the Virtua Main menu. Click on the
General tab.

Select the state to which you want to save the record or select Process
Immediately to save the record to the database

From the Record States window, click on Edit to open the record to be
changed in MARC Editor.

Review or correct the record. Save the record. The record will be saved with the
state set on the General tab of the Load Options window.
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Copy 239.50 Records Workflow

Recommended
Workflow

Explanation

Configure the
Connection

A 4

Obtain the
Record

A 4
Copy Record

A 4

The Z239.50 workflow enables you to copy MARC records
from other Z39.50 databases into your Virtua database.
One example of a Z39.50 database from which you
might obtain records is the Library of Congress.

Z239.50 refers to the International Standard, ISO 23950.
The standard specifies a client/server-based protocol for
searching and retrieving information from remote
databases.

A list of Z39.50 servers, is maintained by IndexData, a
software library that provides the necessary
infrastructure for creating Z239.50 targets (servers) and
origins (clients): http://www.indexdata.dk/targettest/

Edit Record
Summary
y e Configure a Connection to a Z39.50 database
Validate e Connect to a Z39.50 database
Record e Obtain a record from a Z39.50 database
e Duplicate the record in Virtua
e Save the Record to a Virtua database
A 4
Save Record Key Terms
to Database e Duplicate Record
Record e Host Name
e Multiple Connections
A 4 e Port
Attach Item e Profile Name
to Record e Z39.50
Profiler Parameters
Tags to be Deleted: specifies tags and/or subfields to
be deleted from incoming records based on the source of
record (003 tag).
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Configure a Connection
To configure a new connection, all existing connections must be closed first.

To close the existing connection, select File > Close Connection from the Virtua
main menu.

Click on File > New Connection. The Connect to Server window appears.

Fae =
¥ Connect to Server E]
fvailable servers:
Phoenix01

Library of Congress

Setup Conneck Zancel

To add databases to the connection list, click on the Setup button to display the
Server Setup dialog box.

Click the New button to create a new connection.
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W Server Setup E]
Prafile: Profile rame: |New
.
Description: |
Database: DEFALLT

| Record Characteristics
™| | Preferred Fecord Syntas: |

Delete Defautt Load Character Sat: |UTF-E‘ j

| Connect az a generic £239.60 Client (requires Guest login)

Address Aftribute Configuration

Hostriame: Search Type | Aftribute | Marmne | Delete
TCPRIIP Part:

210 [ Use S5L

talor Mew Atribute

(* ﬂf‘“ . ﬂﬂ [ Search Type:  Aftribute: Pame:
® [0 [ |o [0 [o |o [RUNNNNEL | ]

Automatic Login
{* Dizabled (" Usermame only |
" Guest login (" Usermame and Paszwaord |

59

Type in the Profile name, Description (name appears in the Connection List box),

Host name or IP address of the database, and enter the port nhumber of the
database.

e Attribute Configuration - allows you to add any non-standard Z39.50 use

attributes for use when searching non-Virtua databases.

To add a use attribute, enter the following information in the New Attribute

area.

e Search Type: From the drop-down box, select Browse, Keyword, or
Both to specify with which search type(s) the use attribute should be
associated.

e Attribute: In the text box, type the number representing the use
attribute to be used for the search.

¢ Name: In the text box, type a text string that will appear for the use
attribute on the Search window.
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When you have entered all of the required information, click the Add button.
The new attribute information you entered will appear in the information box
immediately above the New Attribute area. When you connect to the configured
server, the attribute name(s) will appear on the appropriate tab(s) of the OPAC
Search window.

The default database textbox should either be empty or contain the name of the
database provided by the library or bibliographic utility.

Note: Configure the Default Load Character Set to specify in which character set
the server you are configuring will store its records. If MARC 21 is selected, record
will be converted to UTF8 when downloaded to your server.

Note: The Connect as a Generic Z39.50 Client (requires Guest login) option allows
you to connect to an older Virtua database with a newer Virtua client. As a Guest,
you have privileges that are determined by the Guest User Profile, which you can
configure via the Virtua Profiler.

Click Save and then OK to return to the Connect to Server window.

Obtain Record from Z239.50 Database

Select File > New Connection on the Virtua menu bar to connect to your local
database. The Connect to Server window will appear.

W Connect to Server E]

Available servers:

Phioenix01
Library of Congress

Setup | Conneck | Cancel

Select the appropriate database and click the Connect button.

Select File > New Connection on the Virtua menu bar to connect to a Z39.50
database.

You may repeat this process to open more databases.

You must set as the default, the Z39.50 database you wish to obtain records
from. Select File > Connection List from the main menu. The Connection
List window will appear.
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Note: The last database to be connected is the default database unless changed.

Click Close to exit out of the List of Connections window.

Search the OPAC for the desired record.

Copy to Local Database

Open the record in the MARC Editor. Click the Save Copy to Database
icon.

If two connections are open Virtua will automatically save the record into the
other database. If more than two connections are open, Virtua will display the
following window:

i o

Choose Connection - LOC

It iz not abwious which connection to send the
record copy to. Please choose the desired
destination connection:

Phoenix3d j

o] 4 | Canicel |

From the dropdown menu, chose the Virtua database to which you wish to add
the record.

Click OK to save the copied record.

Edit the MARC Record

See Record Validation for more information.

Validate the Record

See Record Validation for more information.

Save the Record
See Record Validation for more information.

Add Item Record

See Record Validation for more information.
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Bibliographic Utility Workflow

Recommended
Workflow

Explanation

Configure the
Import Tool

A 4
Run the
Import Tool

Y
Edit Record

A

Validate
Record

y

Save Record
to Database

y
Attach Item

The bibliographic utility workflow is used for importing
into Virtua a file of MARC records that resides on a
locally accessible drive. These records may have been
downloaded from OCLC or another bibliographic utility or
may have been received from a vendor or other source.
Provided the records are in MARC 2709 format, they may
be imported into Virtua using the Import Records Tool.

Summary
e Configure the Import Tool
e Import records into Virtua using Import Tool
e Automatically save records to the database
e Open records in the MARC Editor

Key Terms

e 2709 MARC Communications Format
Character Set

Import Records

Import Tool

UNICODE (UTF-8)

Profiler Parameters

e Value for 003: Sets the value of the 003 tag for
records exported from the Virtua database or
displayed in the MARC Editor.

e Tags to be Deleted: Determines which tags are

to Record .
automatically deleted from records, as they are
loaded to your database.
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Configure the Import Tool

63

Click the Import Record icon E on the cataloging toolbar or, select File =
Records 2> Import Records on the Virtua menu bar. The Import Records

window appears.

-

W Import Records - Phoenix01 E]

Skakus

'__.:\_‘"

0 Tokal Records Found in Source File
0 Failed Malidity Checks

0 Database Errors
i Reset :

0 Successfully Imported B

Configure Skart | Close

Click the Configure button The Import Configuration window appears.

W Import Configuration - Phoenix01 g

Source Opkions
File Mame
|C:'|,Program Files\WTLSWirtua49_Sdistributionprint, utf

Character Set
|uTF-8 -
Farmat

[MaRC 21 =

[~ Recards Are From RLIM

Destination Options
{* Save Records to Database ¢ Open Records in MARC Editor

" Walidate with Database Only

[~ Add Import Filename to Recard

Cancel | ok

Under Source Options, select the name of the file containing the 2709 MARC
communications format records. Click the _| button to browse for the file.

Select the Character Set of the incoming records. Virtua supports UTF-8
(Unicode) character sets. All other character sets must be translated into UTF-8

(Unicode) format.
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Note: If records are encoded in a character set that Virtua does not support, you
will not be able to preview them until you translate them to the Unicode (UTF-8)
character set

When importing RLIN records, check the Records are from RLIN checkbox as
some RLIN records have surrounding characters that must be compensated for and
others don't.

Under Destination Options, you have three options. You may select one of the
following

e Save Records to Database
e Open Records in MARC Editor or
e Validate with Database only

Check Add Import File Name to Record if you want the filename to appear in
the 856 subfield /n tag of the record

Click the OK button.

Run the Import Tool

Click the Start button in the Import Records window. The animation at the top
of the window indicates Virtua is waiting for records. The animation will not stop
even after all the records have been successfully imported.

The Import Records window keeps track of the number of records successfully
loaded, records that fail validity checks, and the number of database errors.

-

W Import Records - phoenix E]

Status

e

0 Total Records Found in Source File
0 Failed Validity Checks

0 Database Errors
0 Successfully Imported

Configure Start Close

When the number of records ceases to increment, click the Stop button.

Note: To stop the Import process before all records are loaded, click the Stop
button on the Import Records window. When you restart the batch load process,
Virtua detects and loads any records that were not saved to the database prior to
the stoppage.
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Edit the MARC Record

65

See Original Cataloging Workflow: Edit the MARC Record. Validation may be

performed: see Record Validation for more information.

Save the Record

When saving a record from a bibliographic utility, the Virtua client takes the
information from the 001 and 003 tags of the incoming record and moves it to the
035 tag of the record. This allows you to save information about the origin of the

record.

W Cataloging Options - Phoenix01

o

2

Tags nok ko Copy inko Mew Editor Mwindow:

Copy Qptions lEditu:ur kKeystroke Mappings ] Other Options ] hl L

001 005 035 039
Subfields not to Copy into Mew Editor Window:

Draka nok to Copy inko Mew Editor Mindow:

From union. (See Cther Cptions)

| Automatically add defaulk library symbol when copying

(]9

Cancel

Add Item Record

From the View Record window, click the Add Items tab. The Item
Information window appears displaying default values for the mandatory item

elements.

Modify Item record data. See Record States: Change Record States for more

information.

Save Item record.
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Item Records

Recommended
Workflow Explanation
Add Item An item record is a record that describes a physical or
Records virtual piece in your library’s collection. The item can
consist of a single piece, such as a book, or of multiple
Obtain Bib pieces in one or more physical formats, such as a multi-
Record CD set with an accompanying printed pamphlet.
A Summary
Add Item e Open and edit an Item Record
Record e Add a new Item Record
e Relate specific item information to its
v corresponding tab
Add Item e Add Statuses to an Item

Add Notes to an Item
e Generate a Spine Label

Information

v Key Terms
Print Spine e Circulation Notes
Label e Item Class
] e Item Record
Edit Item e Owning Location
Records e Shelving Location
e Spine label
Obtain Bib e Units
Record
v Global Settings
Open Item e Library Names
Record e Status Displays
A 4
Edit Item
Information
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Recommended
Workflow Explanation (cont.)
Circulation Parameters

e System: Item Class Definitions, Delete/Waive Flags,
Long Loan Flag

e Cataloging: For Items With No Item-level Call Number,
Retain OIld Call Number When Relinking

InfoStation Reports

¢ Change Item Location by Call Number Range: Lets
you change the location and shelf location in item
records identified by the item-level call number range
specified in the report configuration.

e Item Barcode List: Generates a list of items identified
by barcodes that fall within a barcode range specified in
the report configuration.

e Items Created List: Generates a list of items that were
created within a specified date range or that have a
barcode that falls within a specified barcode N range.
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Add Item Record

The item record is vital for the proper functioning of Circulation and for generating
spine labels. The Item Information window gives details about a physical or
virtual piece in a library collection. While all copies of one title may have identical
bibliographic information, other types of information are unique and differ from
copy to copy.

From the View Bibliographic Record window, click the Add Items button.
The Item Information window appears displaying default values for the
mandatory item elements.

% Item Information - phoenix g

Item Elements lNotes ] Statistics] Status] Acquisitions | Other Elements

Bibliographic Information
Title: Gothic classics f edited by Tom Pomplun.,
Publisher: Mount Horeb, Wis. : Eureka Productions, 2007,
Description: 144p. vill. ; 25 cm,
Item Information Call Mumber
Item ID: 913421 Copy:
Barcode: 31781041121278 Call : IF GoTHIC
Barcode Type: |Regular j 2nd Call #: |
Item Class: |F-"30k ﬂ
Units
Reserves Item Class: | -,
Ttem URL: | o
- f* Mone
Location: |Ho|:-e Mills j li
Shelving Location: |HQ|:|E Mills j
[~ Preservation and Conservation
Code:
Number of Pieces: 1 +| Circulate Pieces: - | J
Price: § 16.95 I~ Mon-Parameterized Shelf Location
Location:
EPM Mumber: | peaton | J
Accession Number: |
Circulation Rules
AV Accession Mumber: | ¥ Use Matrix
’ ; | J (" Use Loan Period: o =
Collection Code: -
Allow Request: v

™ Masked Delete ‘ Save | | Close |

When you click the Add Item Button, the Item Information window contains an
area at the bottom of the window to create multiple items. This area does not
display when you select View Item from the View Bibliographic Record window.
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Note: When adding the first item to a holdings record, the location value is taken
from subfield $b of the 852 tag in the holdings record instead of the login location.

Item Elements Tab

The Item Elements tab contains bibliographic, item, and call number information,
and circulation rules.

Barcode: Displays the barcode assigned to this item. Enter an alphanumeric
string up to 50 characters long. This field is optional, but an item cannot
circulate without a barcode.

Profiler Tip: The Generate Item Barcode Using Prefix setting lets you
determine whether Virtua will automatically generate barcodes for item
records and whether the barcodes will have an alphanumeric prefix. See
Setting the Cataloging Basic Options Parameter: About the Generate Item
Barcode Using Prefix Setting in the Virtua Profiler/Cataloging Parameters
User’s Guide for more information.

Item Class: Item records have 2 item classes. The main item class
determines how the item circulates in Regular circumstances. The Reserves
Item Class is set in the Virtua Profiler for each Item Class and will
automatically be assigned when the book is placed on Reserve.

Profiler Tip: Using the Item Class Definitions parameter, you can define
settings for each item class used in your library. See Working With Class
Item Definitions in the Virtua Profiler: Circulation Parameters User’s Guide for
more information.

Shelving Location: All item records contain two location fields: Location and
Shelving Location. The distinction between the two is that the shelving
location always determines what circulation parameters are applied during a
transaction. This is the field that should be displayed in the item list box of
an Items tab in a View Record window. This value represents the actual
physical location of the item.

Location: Headguarters j

Shedving Location:

Headguarters j

Note: The Location drop-down list is limited to locations that are valid login
locations for the current user (as specified via the User Profiles parameter in
the Virtua Profiler).

Profiler Tip: The Location Names parameter lets you define library locations
and represent the physical and/or virtual locations of library materials. Using
the Location Names parameter, you can set up both main locations and
sublocations. Library locations and their codes reside in the Location Names
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parameter, which is located on the Global Settings tab of the Virtua Profiler.
See Working With Class Item Definitions in the Virtua Profiler: Global
Settings User’s Guide for more information.

The At Shelving Location Until check box is active only if the Shelving
Location and the Location fields contain different values. The assumption is
that if the Shelving Location is different from the Location, this is a
temporary condition. The At Shelving Location Until date field displays the
date that the item is due to be moved from the shelving location to the
owning location. This field appears only if the shelving location is different
from the permanent location. If the item is on reserve, the At Shelving
Location date is the end date of the reserve active period.

Location: |Hea|:|quarters ﬂ
Shelving Location: |East Regional j
[+ At Shelving Location Until | Q/23/2013 j

¢ Non-Parameterized Shelf Location: Lets you choose a shelf location that
is associated with the item but that is not associated with Virtua’s existing
parameterized shelving location functionality. Non-parameterized shelf
locations must be defined in the Virtua Profiler (Under Cataloging, see
‘Non-Parameterized Shelf Locations’). If no locations are defined, the
feature is disabled on the Item-Information window.

Profiler Tip: The Non-Parameterized Shelf Locations parameter lets you
specify shelf locations that are not parameterized. The shelf locations
configured in the Virtua Profiler will populate a drop-down list on the Item
Information window in the client. In this way, you can associate a non-
parameterized shelf location with the current item. See Setting Non-
Parameterized Shelf Locations in the Virtua Profiler: Cataloging Parameters
User’s Guide for more information.

e Call Number: Displays the call number assigned to the item. This primary
call number may be inherited from a parent bibliographic or holdings record.

Profiler Tip: The Virtua Cataloging subsystem offers several configurable
settings to adjust the system’s call number settings to match your library’s
needs. See Setting Call Number Parameters in the Virtua Profiler/Cataloging
Parameters User’s Guide for more information.

¢ Units: This is a free text field for use with a multi-volume work. It performs
the same function as the 866 tag in the holdings record. To have a Units
column display in the View Record window, configure the View
Record/View Holdings Record view (Items tabular display) in the Profiler.
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Price: Displays the price of the item. Enter a number ranging from 0 (zero)
through 9999.99. This field is used for billing a patron for the replacement of
an item that has not been returned.

Profiler Tip: When a patron checks out an item and does not return it within
the specified period of time, your library can bill the patron for the
replacement cost of the item. See Working with the Location + Item Matrix:
About Item Replacement Values in the Virtua Profiler/Circulation Parameters
User’s Guide for more information.

EPN Number: An optional alphanumeric identification number that you can
assign to an item and later search for via a control number search. [The EPN
is the Bib ID of the associated record in the French Union Catalog (SUDOCS)
shared by all the universities in France.] The EPN Number must be unique,
and has a maximum length of 24 characters.

Accession Number: An optional alphanumeric identification humber that
you can assign to an item and later search for via a control number search.
The Accession Number must be unique, and has a maximum length of 35
characters.

AV Accession Number: Displays the AV accession humber assigned to this
item. Type or scan in an alphanumeric string of up to 35 characters. The AV
accession number does not have to be unique.

Collection Code: Displays the collection code associated with the item. This
element is optional as your library may not use collection codes to organize
items in its collections. To choose a collection code, click the arrow in the
drop-down list and make a selection. The list contains all of the collection
codes defined in the Collection Code Definitions parameter on the Cataloging
tab in the Profiler.

Profiler Tip: The Collection Code parameter is an optional parameter that
can be used to help you keep track of items in your collection. See
Configuring Collection Codes in the Virtua Profiler/Cataloging Parameters
User’s Guide for more information.

The Lamination field provides a drop-down list of values to describe the
state/type of lamination: No lamination (0), Paperboard (1), Plastic (2), and
Other (3). The default value is 0 (zero) for all items, including those created
from the Acquisitions subsystem.

Statistics Tab

The Statistics tab contains information grouped by bibliographic information,
record information, and circulation statistics.

Bibliographic Information: displays up to three fields from the linked
parent bibliographic record. You cannot edit this information on the Item
Information window, but you can configure the header in the Item
Information view in the MARC View Editor in the Profiler.
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e Circulation Statistics: Circ count, temp circ count, etc. is maintained by the
software. Last Inventory Count is not yet available.

Notes Tab

The Notes tab displays public and staff notes and check-in and check-out alerts
regarding the associated item. The maximum size for a note is limited to 250
characters.

Status Tab

If the item has acquired a special or system-defined circulation status, the Status
tab will appear on the Item Information window in view mode.

e To Location: is used by the status In Transit only. It displays the In Transit
To destination location of the item.

¢ Report: displays the number of times this status has appeared on a report.
The software automatically increments the value of this field.

Profiler Tip: The Status Displays parameter lets you control various aspects of
special and system-assigned statuses. Using the Status Displays parameter, you
can set up special statuses and modify some aspects of system-assigned
statuses. See Setting Up Item Statuses in the Virtua Profiler: Global Settings
User’s Guide for more information.

Profiler Tip: In the client, Virtua will use the values you set on the
Lost/Damaged tab of the Location + Item Matrix to calculate the total price
billed to a patron’s account to replace a lost or damaged item. These default
values will appear on the Process Lost/Damaged Item window when, on the
Activity tab of the Patron Information window, you click the Lost button or
Damaged button. You will be able to edit the values on the Process
Lost/Damaged Item window. You will also be able to see the values on the
Acquisitions tab of the Item Information window in the client.

To set the values for the depreciation rate, maximum depreciation, binding cost,
lamination cost, and surcharge on the Lost/Damaged tab for the location/item
class combination, see Setting Values in the Location + Item Matrix: Setting
Values on the Lost/Damaged Tab in the Virtua Profiler: Circulation Parameters
User’s Guide for more information.
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Acquisitions Tab

The Acquisitions tab displays bibliographic and acquisitions information for the
item. On the Acquisitions tab of the item record, acquisitions information is linked
to the item record. The fields listed are: cost, purchase order number, order line
number, vendor name, and receipt date.

To prevent non-acquisitions users from being able to access Acquisitions
information, new Operational Security permissions have been added to the Virtua
Profiler. These permissions will control which users will be able to see the
Acquisitions tab on the Item Information window and the Statuses tab on the
View Bibliographic Record window.

W Item Information - Phoenix99 E]

ttem Elements | Motes | Stafistics | Status  Aequistions
Bibliographic: Informnation

Athar: Kiostova, Elizabeth.
Title: The histarian : a novel f Elizabeth Kostova.
Edition: 1=t ed.

Acquisitions Information

Purchase Order Id: B251
Purchase Order Line Mumbet: |1
Receipt Date: [v Use Date: (20104202 -

Ivaice Mumber: |

Wendor: Halm Publishing

Invaice Unit Price:

Invoice CUrrency: J
Ihwroice Unit Discount:

Ihwaice Unit Fee:

[ Masked Delete | Sawe | Cloze
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Barcode History Tab

The Barcode History tab displays information about barcodes that have been
previously assigned to an item, and only appears when the Maintain Item Barcode
History parameter is enabled.

Profiler Tip: The Maintain Item Barcode History setting controls whether Virtua
maintains a history of the item barcodes that have been assigned to any given
item. See Setting the Cataloging Basic Options Parameter: About the Maintain
Barcode Item History Setting in the Virtua Profiler/Cataloging Parameters User’s
Guide for more information.

If you select the Maintain Item Barcode History check box, Virtua will. . .

e Maintain a history of all previous barcodes that have been assigned to an item.
-AND-

e Display an item’s barcode history on the new Barcode History tab of the Item
Information window.

-AND-

e Prevent a new item barcode from being saved if it duplicates a barcode currently
in use, an item barcode that was previously used, or a barcode of a deleted item.
-AND-

¢ Allow you to search on barcodes that were previously assigned to items and
barcodes for deleted items.
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W Item Information - Phoenix99 o [ E
tern Elemerts I Statistics I Status I Acquistions
— Bibliographic Information
Author: Kostowva, Elizabeth.
Title: The historian : a novel § Elizabeth Kostova,
Edition: 1st ed.
Old Barcode | First Used Dete | Last Used Date |
2010M 2102 1:44:41 P 2010M 202 1:46:12 P
wils2345 2010202 1:46:12 P 20100202 1:49:17 P
[~ Masked Delete Edit Refresh Close
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Add or Modify Item Information

W Item Information -

phoenix

Mumber of Pieces:

Price:

EPM Number:

Accession Number:

Author: Kostova, Elizabeth,

Title: The historian : a novel / Elizabeth Kostova.
Edition: 1sted.

Ttem Information

Item ID: 725859

Eorerie |31781032017379

Barcode Type: |Regu|ar j
Ttem Class: ook |
Reserves Item Class: |

Ttem URL: |

Location: |C|if'f:'2|fl|E ﬂ
Shelving Location: |C|if'Fc|a|e ﬂ

1 %| Croulate Pieces: [~
£30.95

Item Elements | Notes | Statistics | Status | Acquisitons | Other Elements
Bibliographic Information

Call Mumber

Copy:

call =: [F kosTOVA

ndcall £ |

Units

(" Free Text
o~

{* Mone

EN

[ Preservation and Conservation

Code: | J
[ Mon-Parameterized Shelf Location
Location: | J

Circulation Rules

[ Masked

AV Accession Number: | * Use Matrix
" - | J " Use Loan Period: 0 T
Collection Code: -
Allow Request: v
Delets | Save | ‘ Close ‘

Enter a barcode of up to 50 alphanumeric characters.

76

Note: Virtua will automatically assign barcode and copy numbers to multiple items
if the increment barcode and copy humber boxes are checked.

Accept or change the default item values where applicable.

Note: Putting a value greater than 1 in the Number of Pieces box will trigger check-
in and check-out alerts.

Create multiple items if desired.

Click the Save button.
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Click the Refresh button on the View Bibliographic Record window. If this is
the first item record attached to the bibliographic record, an Item tab appears.

Add Item Notes
Virtua allows the user to add two types of notes to item records; Circulation Notes
and User-defined Notes. Both types of notes are keyword searchable.

Circulation Notes

Click on the Notes tab. If there is not a Notes tab, click the Edit button, a
Notes tab will appear.

W Item Information - phoenix g

Itern Elements Motes ]Smtistics] 5131:us| Acquisitions | Other Elements
Bibliographic Information

Author: Kostova, Elizabeth,
Title: The historian : a novel / Elizabeth Kostova.
Edition: lsted.
MNotes
Public Motes: Staff Notes:
Incdudes CD-ROM. Copy of CO-ROM in storage.
Checkout Alert: Checdkin Alert:

Check for CD in pocket.

[ Masked Delete | Sawve | Close
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Note Description

Public Note Note that appears in the OPAC

Staff Note Note that can only be viewed from the Notes Tab

Checkout Alert Note that pops up on “alert” during checkout/renewal
of an item.

Checkin Alert Note that pops up on “alert” during the checkin
process.

Click the Edit button. The Item Information converts to edit mode, and a
Save button replaces the Edit button on the window.

Select the Notes tab. Add, modify, or delete text in the Public Notes and Staff
Notes fields as you would in any text box.

Click the Save button to save your changes.

Add Copy-Specific Notes

Copy-specific notes are additional notes that may be added to item records to
provide additional information about an item. You may also add copy-specific notes
to holdings records.

On the Item Information window, click the Edit button.

From the right-click pop-up menu, select More Notes.
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W ltem Information - phoenix u i ‘E

Notes I Smﬁsh’csl Other Elements I
rBibliographic Information

Shelving Location:

Author: Kostova, Elizabeth,
Title: The historian : a novel / Elizabeth Kostova.
Edition: 1st ed.
Item Information all Mumber
Ttern ID: 726859 Copy: I
Barcode: |31781033017379 What's This?
Barcode Type: I:é; ular ;I Append/Print Spine Label
= Clear Label File
Item Class: Coo o
m ass I J Append,Print Property Label
Reserves Item Class: I Clear Property Labels
Ttem URL: | Patron Ac
Location: IC fhdale =l

Item Requests
Bib Requests
MNumber of Pieces: I'— vl Circulate Rieces: 7| auditTrail...

Transaction Leg. ..

I<_\|_

. E-mail 3

— 1

Collection Code:

Price: Etion
Parent Record

EFM Mumber: I Bibliographic Fecord j'
More Motes

Accession Number: I
Print

AV Accession Number: I Save

&llow Requesk; W

[ Masked Delets | Edit | Refresh | Close |

A window will open allowing you to navigate to the appropriate cataloging
workform.

Create Mew Mote Record W
Laak ir: I [ Catalog j L |‘_"“F v
rnap. wim otelab.wfm| simple. wfm
rnaplab.wfm patrnlab. wfrm wis wfn
rized. whm patron.wfm wislab, wfm
mizedlab. whm sample.wkm
rnusic, i seril.wfm

musiclab. wkrm serillab . wfm
[i] I m
File hame: Inatelal:n Open I

Files of lwpe: ILlser wdorkforms [7winm) LI Cancel
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Select the notelab.wfm workform and click Open. The workform will appear in the
MARC Editor.

Note: The Default Workform option on the File Options tab of the Cataloging
Options window allows you to decide which workform will appear in the MARC
Editor automatically when creating a new copy-specific Notes record for a holdings
or item record. If you do not select a default workform to appear by default, the
Create Record window will appear so that you can choose one.

W Cataloging Options - Phoenix99

] Display Options | Copy Optians R

File Options | 1

Default Workform:

| =

Default Cther Wiorkdform:
|C:'I.ngram Files™WTLSWirtua2010.1 .3 Catalogil (=

Default Motes Workform:
|C:'I.ngram Files™WTLS201 0. Cataloginotelab wim - (=

Defaut Holdings wharfarm:
|C:'I.Pr1:|gram Files™WTLS2010.1 3\Catalogholds wim (=

| el

] | Cancel
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& MARC Editor - Phoenix01

M=%
Tag 008 [G90z20 |
Tag 035, Subfield a [ ][] [vTLsnoTEIODDEE2036 |
Tag 909, Subfielda [_|[ ] |
Tag 910, Subfielda [ |[ ]| |
Tag 911, Subfielda [ |[ ]| |
Tag 912, Subfielda [ |[ ]| |
Tag 913, Subfielda [ |[ ]| |
Tag 914, Subfielda [ ][ ]| |
Tag 915, Subfielda [ |[ ]| |
Tag 916, Subfielda [ |[ ]| |
Tag 917, Subfielda [ ][ ]| |
Tag 918, Subfielda [ ][ ]| |
(1) NoteType_| |y ke =
:}mm: 21 GlobTypehiote: MTagSubshiate NewRecord | Modified
\Untitled1 /

¢ Note fields are repeatable

¢ Note fields may be labeled by editing the tags in the Label Editor

e Additional note fields may be added to the workform.

.

035 tag, Subfield $a contains the system id of the item. This information is

system generated and should not be changed.

Enter copy-specific notes in the appropriate categories.

To save the record, select File > Save Record from the Virtua menu or use the
F11 key. The MARC Editor window will close and note tags that do not contain
data will be removed from the record.
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W View Notes Record - Phoenix(1 g@

Full

s

LDF.
001
003
005
00g
035
039
Q09
299
999

00329nll 82200133 a 4500
wtls000257875
MeFayC
2009021711.35300,0
090217
ha WTLSMOTEIOOOESS019
9y 200902171138 \z staff
\a from the collection of Samantha Hristowa
\a ¥TLSSORTO0S0*0350%9030%3991
Ya WIRTLA

Edit Refrash Close

To add copy-specific notes to an item record:

On the Item Information window, click the Edit button.

From the right-click pop-up menu select More Notes, which will either open a
default workform or allow you to choose one.

Create and save the Notes record as appropriate.

Copy-specific notes records for items have the following features:

The 035 tag is automatically created with the prefix "VTLSNOTEIL" followed
by the item ID (9 digits zero-filled).

The type of record field (leader position 06) contains an “I” to indicate
that the record type is Note.

e The bibliographic level field (leader position 07) contains an “|” to indicate
that the bibliographic level is Note.
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View Copy-Specific Notes

The presence of a copy-specific note is indicated on the View Bibliographic
Record window by an asterisk to the left of the item information.

83

W View Bibliographic Record - Phoenix01 M=%
i A R
Ful  Ttems |marc | Statuses |
Title: The story of Halloween | by Caral Greene ... Siglils (ol
ISER: 0060295500 : Che::ked Qut: 7 On Reserve: a
Publication: Mew York : HarperCallins, c2004, Ma"aille' i Re:uested. o
Description: 1w, scalll ;21 x 21 cm, O (el eh o iy o
Format/Edition:  1st ed, Total Ikems: g IUnsatisfied Fequests: 0
Tatal Reguests: 0
Call Murnber | Location Gente | Skatus | Barcode Mumber | Eooo | Liniks | Last Circula) &
* 1394, 264 G Headquarters Due: 10)... 31781033026983 1/20/2006 .
1394264 5 30000 Due: 10f... 31781038025670 g/28/2006 .
1394 .264 G 40000 Due: 10)... 31781033067433 3/ef2006 5
1394264 5 40000 Due: 10/... 31781038025316 7l2zizong .
1394264 G S000a Due: 10)...  317810383025373 10/2/2006 | 7
[l 3
Current Selection: 118 | Wiew Ikem ‘ Delete Item | Reqguest Item |
[ Masked | Edit | Request Bib ‘ Add Item ‘ Refrash ‘ Close ‘

To view copy-specific notes, double click on the item or highlight the item and
click the View Item button. The Item Information window will appear.

If there are notes for this item, the following message appears in bold on the
upper right corner of the Item Information screen: “* Copy-specific Notes

Exist”.
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¥ Item Information - Phoenix99 g |

* Copy-specific Notes Exist

fem Elemerits |N|:|tes | statistics | status | acquistions | Barcode History
~ Bibliographic Information

Authar: kiostowa, Elizabeth.
Title: The historiah : a nowvel § Elizabeth Kostova.
Edftiat: 1=t ed.
kem Information ~Call Mumber
tern 10 1121239 Copy: I
Barcode: 153333 call # [F kosTOVA,
Barcode Type: IReguIar j Ind Call #: I
tem Class: IBC'C'PC j
RPezerves bem Class: I
" Unitz
tern URL: I £ Free Text
Location: IHeadquarterS j = Erurneration and Chronology
{* hone

Shelving Location: IHeadquarters j

I Ediit

Mumber of Pieces: 12 Circulate Pieces: [
1 Preservation and Conservation —

Code: I j

Price: I % .00

EFM Mumber: I

Accesszion Mumber: I

Larmination: INane j
Circulation Rules Maon-Parameterized Shelf Location
f Usze Matrix  { Use Loan Period: = Lemaiime I j

Al Request: v

[~ Masked Delete | Save Eefresh | Close |

To view the notes, right mouse click on the Item Information window and
select More Notes.
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o Item Information - Phoenix01 g

* Copy-specific Motes Exist

Ttem Elements |piates | Statistics | Status |

Bibliographic Information tihat's This?
Aukhor: Gareens, Carol, AppendfPrint Spine Label
Title: The stary of Halloween | by Carol Greene ; illustrated B Clear Label File
aclifsi b e Patron Ackivity
Item Information Call Murnt
Barcode: | Copy: CheckIn...
Rengw...
Item Class: |BDDK j Call #:

Ikem Requests
Bib Requests
LInit= Audit Trail. .

Reserves Ikem Class: |

Item LIRL: |
™ Frea Transackion Log. ..
Location:
|Hea|:|quarter5 ﬂ & Parent Record

shelving Location: Headquarters -] f+ Mor  Bibliographic Record

Mare Mokes

Prink
Mumber of Pieces: |1 ¥ Circulabe Pieces: [ | [T Presg  Save

: Code: E-rnail
Price: | $71.69 Qe 1 —
Circulation Rules [ Mon-Parametetized Shelf Location
{+  |lse Matrix " Ise Loan Period: o v Location: J
Allow Request: v
Delete | Save | Close

The View Notes Record window will open displaying the copy-specific notes.
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W View Notes Record - Phoenix(1 g@

LOR. 00329nll 82200133 a 4500

o1 wtls000257875

o3 MeFayC

aos 2009021711.35300,0

0o0s 090217

035 ha WTLSMOTEIOOOESS019

039 9y 200902171138 \z staff

Q03 \a from the collection of Samantha Hristowa
999 \a ¥TLSSORTO0S0*0350%9030%3991

999 ha WIRTUA

Edit Refrash Close

Click the Edit button to add more notes.

If copy-specific notes do NOT already exist for an item record, you may add them.

Copy-Specific Notes for Holdings

If copy-specific notes exist for a holdings record, on the Holdings tab of the View
Bibliographic window, an asterisk (*) will appear to the left of the location name for
the holdings line.

To view existing copy-specific notes:

From the right-click pop-up menu on the View Holdings Record window, select
More Notes.

If copy-specific notes exist, they appear in the View Notes Record window.

If copy-specific notes do NOT already exist for a holdings record, you may add
them.

To add copy-specific notes to a holdings record:

On the View Holdings Record window, from the right-click pop-up menu select
More Notes, which will either open a default workform or allow you to choose
one.

Create and save the Notes record as appropriate.
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Copy-specific notes records for holdings have the following features:

e The 035 tag is automatically created with the prefix "WVTLSNOTEH"”

followed by the holdings ID (9 digits zero-filled).

e The type of record field (leader position 06) contains an “l” to indicate

that the record type is Note.
e The bibliographic level field (leader position 07) contains an “1” to indicate
that the bibliographic level is Note.

Item Statistics
Click on the Statistics tab to view circulation statistics for the item.

Note: The Statistics tab will not appear when you are creating the item record.

You must save the item record first.

W Item Information - Phoenix99

BE X

Recond Information

tern Elements | Motes  Statistics lStatusl Acquisitions | Barcode History
Bibliographic Infarmation

Auttor Kiostova, Elizabeth.
Title: The hiztariat : a nowvel § Elizabeth Kostova.
Edition: 1=t ed.

* Copy-specific Notes Exist

fern 10 1121239 Lazst Maodified: 20100 202
Barcode Date: 20108 2002 by Opetator 1D: 9
Date Created: 20100 202
Circulation Statistics
Cire Count: 1] In House Circ Court: 1]
Temp Cinc Court: ] Temp In House Cing Court: o
Since: 20100 202 Since: 201001202
Reserve Court: ] Last Inwentory Date:
Temp Reserve Coutt: 1] Last Circulation Date:
Since: 201001 2/02
™ Masked Delete | Sawve | Cloze
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On the Statistics tab, the statistical data elements are organized into three logical

groups:
Group Description
Bibliographic Displays up to three fields linked from the parent

Information

Record
Information
Circulation
Statistics

Add Item Status

Bibliographic record. You cannot edit the information
but you can change the information that displays by
modifying the View in the Profiler.

Displays system data about the item record.

You cannot reset Temporary Circulation or Temporary
Reserve counts. Last Inventory Date is not you
available.

From the Status Tab of the Item Information window:

Click on the Status tab of the Item Information window.

Click the Edit button. The Item Information window converts to edit mode, a
Save button has replaced the Edit button.
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W ltem Information - Phoenix99 g O
* Copy-specific Notes Exist
tern Elementsl Motes | Statistics  Status |Acquis'rtions Barcode History
—Bibliographic Infarmation
Authar: Kiostova, Elizabeth.
Title: The hiztariat : a nowvel § Elizabeth Kostova.
Editian: 15t ed.
—Statuzes
Status | Date 2dded f Checked .. | Location ¢ Due Date | To Location | Report # |
In Processing |QD1DJ‘1 2mz2 |Headquarter3 |D
Add Modify Delete
[~ Masked Delete | Save I Refresh | Close |

Select the Add button; a dialog box appears for adding statuses.

o Add New Status

Ax]

Skakus: I

Locakion: IHeadquarters

Ok,

Zancel

=
=
|

Click the Save button to save your changes.
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EPN Number Field in the Item Record

The EPN Number field on the Item Elements tab of the Item Information
window displays the EPN Number associated with the item. The EPN Number is a
library-assigned control number. A EPN Number control number search allows you
to search on the EPN Number value (for details, see the OPAC User’s Guide).

Item ID Field in the Item Record

The Item ID field on the Item Elements tab of the Item Information window in
the client is read-only.

The item ID is being displayed more prominently because for some customers, the
ID will serve as the auto-generated accession number.

W Item Information - Phoenix9% g

* Copy-specific Notes Exist

tem Elements ] Motes ] Statistics l Status l Acnuisitions | Barcode History
Bibliographic Infarmatian

Auttor Kioztowva, Elizabeth.
Title: The histarian : a novel f Elizabeth Kostowa.
Editian: 1st ed.
tem Infotmation Call Mumnber
——» ttem ID: 1121239 Copy:

Barcode: |"'“33333 Call #: |F KOSTOWA,
Barcode Type: |RBQU|3" j 2nd Call #: |
fern Class: |B'30k j
Reserves tem Class: |

Units
ftem LURL: | & Fres Tod
Location: |Headquar‘ters j i

(¥ Mone

Shehving Location:  |Headguarters |

=

-
Mumnber of Pieces: ! »| Circulate Pieces: [

Price: $ 00

[ Preserwation and Cohservation

Code: J

9 EFH MNumber: |

Acceszion Mumber: |

Larninatian: |None j
Circulation Rules [ Mon-Parameterized Shelf Location
(* Usze hatrix " Usze Loan Period: 7 : Lacation: | J

Allow Request: v

™ Masked Delete | Save | | Cloze |
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Barcode Type Field in the Item Record

Use the Barcode Type drop-down list on the Item Elements tab to select a
barcode type of Regular, RFID, or Both. In this way, the information may be stored,
displayed, and used in SQL searches.

Generate Individual Item-Level Spine Labels

Customize the LabInput.txt file to contain the codes of the data elements that
you want to appear on the spine label.

On the Item Information window, click the right mouse button. The pop-up
menu appears

What's This?

AppendPrint Spine Label
Clear Label File
Append/Print Property Label
Clear Property Labels

Check Cut...

Item Bookings
Item Reguests
Bib Requests
Audit Trail. ..
Transaction Log...

Parent Record
Bibliographic Record
Maore MNotes

Print
Sawve
E-mail

Choose Append/Print Spine Label. Virtua extracts the data elements from the
item record and its parent bibliographic record and displays the Append Label
form

Edit the data elements of the label as needed

Click the Print Immediately button to print just the label in the window. The
label will print using your default printer.
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Note: You can also use a third-party program to print multiple spine labels. This is
described in Appendix B: Generating Spine Labels Using Word 2000 ® and
Appendix C: Generating Spine Labels Using Word XP ® of the Cataloging
Configuration and Authority Control training guide.

Print Spine Labels from Holdings Record

Spine labels can be printed from the View Holdings Record window by selecting the
Append/Print Spine Label option, which is accessible from the pop-up menu and the
View Holdings pull-down main menu.

This feature uses two files:

HoldLabInput.txt - Default spine label input text file
HoldSpineLab.txt - System-generated spine label output text file

Note: Holdings spine labels (via the HoldLabInput.txt template) can
accommodate other record data besides the call number from the 852 tag.

Re-link an Item Record

Occasionally an item record may be accidentally attached to the wrong bib record.
Rather than deleting the item record it is possible to link it to the correct bib record.

Note: You can use the relink function when multiple connections are open, but you
cannot relink item records across databases.

Note: You can relink items without barcodes.

In the View Bibliographic Record window, open the record that has the
incorrect item attached.

Highlight the incorrect item(s), right mouse click and select Hold Item(s) for
Relink from the menu.
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7 View Bibliographic Record - Customer Support Library VWhat's This? @@ N
Print...
]
Fur  [ltems | MARC | Statuses PP
———— et E-mad...

Tte The story of Halloween / by Carol Greene ; ilustratec

ISBN 0060295600 ve: 0

Publication: New York : HarperColins, c2004 d 0

Description 1v.:colill;21x21cm 0

FormatEdtion: 1sted d Requests: 0

Subject: Haloween Juvenile Rerature Item Bookings s o
Item Requests

Call Number J shelving Location l | -

J354264 G Headquarters

J3842684 G Bordeaux

J394264 G Ciffdale Hold Item(s) for Reink

J384284 G Cifidale v

4 »

C::fse = Show Group I Create Holdings Record I Reguest ltem
Create Holdings from Workform L
[~ Masked  AgencyReq J | Ea ’ | _J —JM

In the View Record window, open the record to which the item should be
attached.

Right mouse click and select Relink Item(s). The item is now attached to the
correct bibliographic record.

Note: When relinking items with no Item-level Call Number, you can choose to
retain the old Call Number when relinking. This is a parameter set in the Profiler.

Merge a Bibliographic Record

Occasionally you may have two bibliographic records, both with items attached,
that you wish to merge into one record. Rather than re-link multiple item records
and then delete one of the bibliographic records, you may merge the bibliographic
records and retain the item records from both bibliographic records.

In the View Bibliographic Record window, open the bibliographic record that
you wish to delete.

Right mouse click and select Hold Bib for Merge from the menu.

In the View Bibliographic Record window, open the record to which the
item(s) should be attached.

Right mouse click and select Merge Bib and Related Records. The item is now
attached to the correct bibliographic record.
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W View Bibliographic Record - Phoenix01

<] J 11
Fudl IW|
] 01793cam 4220045118 4500
001 V000267873
00 McFay
n0s 20080906121200.0
)] 05122152004 ko 000 1 kor d
035 Ya (CCol ChocmiS6958931
0% 12 200305061212 \b VLOAD ¢ 200804082131
040 & 20P e 20P \d CUT Y4 TRBCP {d HOE
D& 1 1
020 \a 8957590765 (pbk. : v. 1) : \c $17.60
020 12 6957590773 (pbk. : v, 2) : \c $17.60
020 |3 B9STSR07ST (sat)
041 & kor \h &ng
043 1a ey
View Archive [ Edit:

[~ Masked

‘What's This?

Print....
Print Tree...
E-mail...

Add Symbal...
Delete Symbed, ..

Bib Requests

Hidd Bib For Merge
Merge Bib and Related Records
Poedaase Bib

Hold Ttem{s) for Relink

Creabe Holdings Record
Creste Holdings Fram Workform

=Joed

Note: If you select the incorrect record and wish to release the record from being
merged, select Release Bib from the pop-up menu.

Delete I1tem Records

Only users with proper permissions may delete item records. When the software
receives a request to delete an item record, the software checks for the following:

Current circulation transactions
Current fees

Outstanding requests
Library-defined statuses

If any of these elements exist, the system will display an error message similar to

the one below.

-

W Messages - Phoenix01

BEx]

Record Update Failed
Error: Cannot delete ikem while it is in circulation,
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To delete an item record from the database:

Open the record in the View Record window.
Click the Items tab. Highlight the item you want to delete.
Click the View Item button. The Item Information window appears.

Click the Delete button. A Confirm dialog box appears.

- ,

Confirm

9P The highlighted records will be deleted From the database! Are wou sure wou want o delete these records?
-

Click the OK button.

If no circulation transactions exist, the process continues. Otherwise, an error
message describing the problem appears.

Profiler Tip: Circulation Basic Options consist of a variety of circulation settings
that control various aspects of the Circulation subsystem. On the Circulation
Basic Options window, you can set the following Delete/Waive Flags: Delete
Special Status and Delete Outstanding Requests. See Working with Circulation
Basic Options: About Delete/Waive Options in the Virtua Profiler/Circulation
Parameters User’s Guide for more information.

Use Batch Item Editor

Users with proper permissions can use the Batch Item Editor to...

e Make batch changes to and deletions of item records from the Item
Elements tab.
e Add, modify, or delete item statuses from the Statuses tab.

Select Items to Batch Edit

To access the Batch Item Editor from the Virtua Main menu select File >
Records > Edit Item Records.
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W Batch Item Editor - Customer Support Library E] [
Item Elements l Statuzes ]
Spedfy Item Barcodes
Item Barcode: Item Barcodes For Modification:
| Clear
Load From File
Load From List
Ttem Information Call Number
Item Class: | ﬂ Copy:
Reserves Item Class: | Call : |
Ttem URL: | mdcall # |
Location: | ﬂ Units: |
Shelving Location:
< | ﬂ [ Preservation and Conservation
Code: | J
Circulation Rl
Mumber of Pieces: m reuiation suies
™ Use Matrix Allow Request: [
Price: | £ 0.0000 (" Use Loan Period: 0 -
Collection Code: | ﬂ
[~ Apply Masking Value:
I
[~ Motify (and do not update) — | Delete ‘ Close |
when last item is Unserviceable

For any Batch Item update, you must first specify item barcodes of the records
to be modified in the Item Barcodes for Modification using one of the

following methods:

Type each item barcode in the Item Barcode field, a

OR

local file of item barcodes.

Note: You cannot mask item records from this Batch Item

Basic Cataloging Workflow-Based Reference Guide
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nd then press Enter.

Click the Load From File button, and in the Open [File] dialog box, select a

Editor.
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Modify Item Elements

On the Item Elements tab of the Batch Item Editor, complete the fields for
the elements to be modified.

Click the Save button.

Delete Item Records

On the Item Elements tab of the Batch Item Editor, click the Delete button.
Confirm the deletion.

Profiler Tip: Circulation Basic Options consist of a variety of circulation settings
that control various aspects of the Circulation subsystem. On the Circulation
Basic Options window, you can set the Allow Withdrawal of Checked Out Items
setting, which determines whether Virtua allows the deletion of checked out
items (e.qg., items with the status Long Overdue) via Withdrawal lists in the
Batch Item Editor. For this feature to work properly, the Delete Special Status
check box should also be selected. If you want Virtua to allow deletion of
checked out items via the Withdrawal workflow, select this Allow Withdrawal of
Checked Out Items check box; if you do NOT want Virtua to allow deletion of
checked out items via the Withdrawal workflow, de-select this check box.
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Load From List

The Load From List option allows you to select records to be modified or deleted
by specifying a Withdrawal Copy Saved List that was created in Chamo.

& Batch Item Editor - Customer Support Library g [

Item Elements | Statuzes |

Spedfy Item Barcodes
Item Barcode: Item Barcodes For Modification:

| Clear |

Load From File

[
S

Load From List

Item Information rCall Number
Item Class: I ;I Copy: I
Reserves Item Class: I Call =: I
Item URL: | nd Call #: |
Location: I ;I Units: I
Shelving Location:
“ I j 1 Preservation and Conservation —
Code: I ;I

Number of Pieces: Iﬂ rCirculation Rules

x ™ Use Matrix Allow Request: [+
Price: | £0.0000 " Use Loan Period: I?

. : 0 -
Collection Code:
I j 1 Apply Masking Value:
[~ rask
I™ Notify (and do not update) Save | Delete | Clase |

when last item is Unserviceable

Click the Load From List button on the Batch Item Editor window and type
the name of the Withdrawal Copy Saved List in the Search For Saved List
window.

(X Search for Saved List ... |=) )& |

Saved List Name:

OK I Cancel
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If the list is found in Chamo and the workflow type is "Withdrawal," the barcodes of
the items in the list that qualify for deletion are automatically added to the Item
Barcodes For Modification list box. When a saved list is loaded for withdrawal, the
list name will appear in the lower left corner of the Item Elements tab.

Profiler Tip: The Cannot Delete Item flag in the Item Class Definitions
parameter and Collection Codes parameter is used to prevent an item that
carries that item class or collection code from being deleted. See Working with
Item Class Definitions in the Virtua Profiler/Circulation Parameters User’s Guide
and Configuring Collection Codes in the Virtua Profiler/Cataloging Parameters
User’s Guide for more information.

Shelving Location

The At Shelving Location Until check box is active only if the Shelving Location
and the Location fields contain different values. The At Shelving Location Until
date field displays the date that the item is due to be moved from the shelving
location to the owning location. This field appears only if the shelving location is
different from the permanent location.

In the Batch Item Editor, the Remove At Shelving Location Until date check
box (when selected) removes the At Shelving Location Until date. In this way,

Virtua supports the owning location and the shelving location being different on a

permanent basis. If the Remove At Shelving Location Until date check box is

not selected the shelving location is temporary.

Location: |BEIIEﬁ:|ntE j
Shelving Location: |B-:uru:|eaux j
[~ At Shelving Location Uinti 9/24/2013 |

[ Remove At Shelving Location Until date
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Add, Modify, or Delete Item Statuses

On the Statuses tab of the Batch Item Editor, select a status and location
from the drop-down boxes.

W Batch ltem Editor - Phoenix01 (=)

Teem Elemerts  Statuses |

Add Stabus Update Cueus
News Status: |

LeJ L

MewLocation: |

Modfy
[~ Onby if lstest stabus

Existing Status: | =
=l

Mew Location: |

Debate

[~ Cmby if latest skabus

Existing Status: | ﬂ
Add To Queue

Select conditions for modifying or deleting if necessary.

Click the Add to Queue button

Repeat process for each new status you want to add, modify, or delete.
Click the Save button.

Note: If you select the Only if Latest Status check box and the specified item
records do not meet the criteria, the problem records will be placed in the Virtua
directory in a text file named ItemStatuses.txt with the following information for
your review:

e The action that was to occur (i.e. Modify or Delete).

e The status specified in the Batch Item Editor for deletion or modification.

e The problem items’ current last status.

e The item barcodes of those items that could not be updated.
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Add Notes

On the Notes tab of the Batch Item Editor window, type a note in the appropriate
text box (Public Notes, Staff Notes, Checkout Alert, or Checkin Alert).

%, Batch, Item Editor - clay68

Ttem Elemerts ] Statuses Motes
Mokes
Public Motes: Skaff Motes:
Checkout Alert: Checkin Alert:
Deeletion
[~ Public Notes [~ Staff Maotes
[ Checkout alert [™ Checkin alert
[~ Matify (and do not update) Save | Delete | Close |
when last item is Unserviceable

Select a check box in the Deletion area of the window if you wish to delete existing
notes from item records being edited.

Click the Save button. Virtua adds and/or deletes the specified note(s) to each item
record being edited.
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Item Record Masking

Item records can be masked. In this way, certain users will not be able to view

102

them. If you have permission to mask item records, you may do so by selecting the
Masked check box at the bottom of the Item Information window.

-

W Item Information - Phoenix99

BE ]

EBibliographic Information

e Elemerts INu:ites | statistics | Stetus | Acquisitions | Barcode Histary

A thor: Kinstowva, Elizabeth.

Title: The hiztorian : a novel § Elizabeth kostova.

Editian: 1=t ed.

ke Information Call Mumbet
teern 10 1121239 Copy:
Barcode: |\,-t|33333 Call #
Barcode Type: |Regular j 2nd Call #: |
tem Class: |BC'C4< j

Rezerves kem Clazs: |

Unitz
tem URL: |  Fres Test
Location: |Headquarters ﬂ ~
Shelving Location: |HEEdquarterS j {* Mone

EN

Murmber of Pigces: 1 :|: Circulate Pieces: [

Price: |

% .00
Code:

EFM Mumber: |

Accession Mumber: |

Circulation Fules

Allow Request: v

Larmiration: |Nu:une

| Mon-Parameterized Sheff Location
(¢ =ze Matrix " Uze Loan Period: o = Location:

| Preservation ahd Conzervation

* Copy-specific Notes Exist

—

|F KOSTOWA

[~

| [

[ Masked

Delete ‘ Save |

| Cloze |

Once an item record has been masked, you can view it in Virtua only if you have

permission to view masked records. If you do NOT have permission to view masked
records, Virtua treats the masked records as if they do not exist in your database.
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Existing Record Workflow
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Recommended

Workflow

Explanation

Obtain
Bibliographic
Record

Virtua provides a user-friendly interface for cataloging
material. This section will review the basics of using the
MARC Editor.

Summary
Y e Edit a record
Open Record e Add tags
in MARC e Delete Tags
Editor e Copy Tags between records
e Save a record to the database
e Add an Item Record
v e Save or Delete Bibliographic Records
Edit Record e Print, Save, or E-Mail Bibliographic Records
Key Terms
v e Bib Level Options
Save Record e Leader
to Database ¢ MARC Editor
e MARC Indicator
v e MARC Tag
Validate * Type Options
Record e Validate
e Vericat
A 4
Attach Item
to Record
Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017

*Updated to 16.1



104

Profiler Parameters

e Allow Undelete of MARC Records: allows users to
restore deleted MARC records. (User Record State
permissions on the Global tab of the Profiler must also
be set to allow editing for the record state Deleted.)

e Call Number: Determines how Virtua handles call
numbers

¢ MARC Format Flag: Determines the MARC format
used by your library

InfoStation Report

e Bibliographic Record List: Generates a list of
bibliographic records that meet the criteria set in the
report configuration.

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



105

Obtain a Bibliographic Record

Search the OPAC to verify that a bibliographic record exists.

wf Virtua - Phoenix01

LJEked

Fl= | Search Circulation Acguisitions Opbions Tools Window Help

2] Search by Stake

Defal Author

=1 Tide
Subject
Call Murnber

Patron Narme
Keyword

ISBN

IS5N

LOCH

Patron Barcode
Ibem Barcode

155N Sarials

Serial Abbreviation

Instructor
Course TD

Fa

F&
Fi2

Shift+Fz2

F3
FiD

R R A=

Current connection: Phoenix0l

e If an exact match for the search term is found, the search term will be

highlighted.

e If an exact match for the search term is not found, Virtua highlights the term
above where your search term would fall in the index.

To see the View Records window from a list of records, double click on the title
or click on the title and then click the View button.
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o Browse - Phoenix01

=] oS

Title: pride 2 prejudice

Hits | Terms

._.
o
=,
i
o
(=
o
=
s
s
CL
(m}
ad

—_

— ) = e [R]

Pride & prejudice [DVD wideorecording] / Focus Features presents in assocation with
Studiocanal a Warking Title production ; produced by Tim Bevan, Eric Feliner, Paul
Webster ; screenplay, Deborah Moggach ; direcked by Joe Wright,
Pride : a novel § Lorene Cary,
Pride and extreme prejudice Japanese
Pride and jovy

Pride and jov | Cathie Linz.
Pride and jov [ photography by Charles B, Smith, Jr.
Pride and petticoats | Shana Galen.

Pride and predator
Pride and prejudice [electronic resource] | Jane Austen,

Title: pride 2 prejudice

View

Page Up | Page Do Skip

Delete

Open Record in MARC Editor
From the View Bibliographic Record window, click on the Edit button.

W View Bibliographic Record - Phoenix9%

=X

JJLH

Ful  tems | maRc | statuses |

Title: The histotian © & novel / Elizabeth kKnstova. Status Courts
ISEN: 03 E011770 - Checked Cut: 2 On Reserve: 0
o . . ) Anailable: g Requested: 0
Publication: Mew Yark ; Little, Brown and Co., 2005, O Hold: 0 Other- 5
Description: i, 642 p. : map ; 24 cm.
Format/Edition: 1=t ed. Total kems: g Unsatizfied Pequests: O
Total Requests: o
Call Murnber shelving Location Units Status termn Barcode -
*F KOSTOWA Headquarters I Processing wiE3333
F KOSTOWA, Headquarters Due: 2009/09/05...  31781039017312
F KOSTOWA, Cliffidale Available F7E103901 7379
F KOSTOWA, Cliffdale Auvailable 31781039503532 -
L] 3
Current Selection: 1 /9 | Wiew tem ‘ Delete ttem | Request ttem |
[~ Masked Agency Req ‘ | Edit | Request Bib ‘ Add kem ‘ Refresh ‘ Close ‘

The record will be retrieved into the MARC Editor.
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=] MARC Editor - Phoenix99 =<
[ ]om | [vis000253299 =
[] =] [NeFay= ¥ Tags, Fields and
[] ooz ] [ 2007011000500 0 | _lndicators
[] ooz | [o4092752005 ryuo 0301 eng |
[ Joic ] J[] [w=200-022683 |
[ Jox | ][] [emienizzo cis0ss ]
[Jose ] ][] [eiorcizossoz2ses |
[Jos | ] \a 200701180005 1 VLGAD \c 200506080849 d
btayloric 20056080537 'd btaylor \c 200503071 748
oy JUEUSUA S0 mmcantiu
[ Joa ] ][] [epLciecLcdGimer |
o Jolo] [onmouz |
[Toss | ][] [wrekosTova |
[Joc ] ][] [ kestove. Eizsbetn. |
[ 24 J1][a] [ra e istarion b anovel e Eizsbeth kostova. | _
I:a) Lariguage material :‘ (i Bdoographiten j [~ vasked Type and Bib Level I
<|>| MARC 21 Bb: Bok OPAC «——{__Information Bar |
\OFACT/

|__Tracking Tabs |
Modify the MARC Record

Using the MARC Editor, you can:

Add or delete MARC tags

Edit the MARC Record

Copy tags between records

Modify fixed field values

Change the Type and Bib Level Options

Note: Virtua allows you to decide whether variable field data is in the MARC Editor
is overwritten by your keystrokes.

If the Cataloging Option Overwrite Variable Fields is selected in the Virtua

client, then variable field data is immediately overwritten by your next

keystrokes.

If the Cataloging Option Overwrite Variable Fields is NOT selected in the

Virtua client, then variable field data will not be deleted as you type.
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Preview the Record

When editing a record, you might find it useful to preview the record, to see how it
will appear to the public in the OPAC.

To preview a record:

On the Virtua menu bar, click MARC Editor dropdown menu.

o Twbms - Hesdquaster - Plos ¥
| Mo B dewc MARC Dl Crnimon Aopesnors Canors Tosk wwde beln
]| o] e ety el BN UNI & DoB @ > BES AD = Py @

Lnuum‘

Curvent coneecion: Phosee - staft

Dupdestn Bpeord 1 Hea 'ireins

Wi 13 peor ] s Wioricores. |

- -

Esgart B3 §TLES Format ]

Pt for Thard Foad Ladier :.n ]
|
|
|
|

e

b 3
Lraaset Urecade Cortral Charsder B - I

fe ion e

| b

[

JE B VUOAD e XNEDE0RIEE d Bwgior
e JOCRIRONRNT ' Hiayior i CE00071 T4 iy
DO M8 ' oA

e 0] [ecice e comer

]
OEIEE] Eaes ]
I_":M_DEI P O T, |
[lle M 0] [ia cemmimrn. reaten |
L0 Qv o] [in Tre remormes o cure ' ittt mieiren ]
OEI00 Gus Lo
[0 s e = [t b cgraprites | T shanz

L | MR H B Bock OPRL

T/

Choose Card Screen Preview. The View Record window appears displaying
the record, as it will appear in the OPAC.

o

¥ Card Screen Preview - Phoenix%9

mE]

| marc |
Author: kostowa, Elizabeth.
Call hurnber: [F KOSTOWA]
Title: The historian : a novel ! Elizabeth Kostowa.
ISEM: 0316011770 :
Description: ix, 642 p. map ;24 cm.
Farnat: 1st ed.
Publication; Meww York © Little, Brown and Co., 2005,

Motes: hap on lining papers.

Subject - topical: WEmpires
Fictiot.
Subject - topical: Docult fiction.
Subject - topical: Harrar fiction.
Date (yyyymmdd): 20070118
Analytic Children: Q00253299*

Uszing Yiew from Phoenix99

Close |
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Validate the Record

Virtua uses rules that are based on the MARC21 format for tags, indicators, and
subfields in determining whether or not a record is valid. It is possible to edit the

rules files to reflect local practices. Validation is only possible if Vericat has been
installed on your system.

For details on modifying records see Record Validation.
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Local Records Workflow

Recommended
Workflow Explanation

Access File of Local records are files that contain MARC communication
Local records and tha_t reside on your local PC or a local
Records network hard disk.
Summary
Y e Open a file of local records
Select e Select records to retrieve
Records e Open records in the MARC Editor
e Delete individual local records
e Delete the entire local record file
A 4
Edit or
Extract Key Terms
Records e Extract Records
e Local Records
A 4
Validate the
Records
A\ 4
Save Record
to Database

y

Attach Item
to Record

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



Access Local Records
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Click the Edit Local Record icon on the Cataloging toolbar or select File >
Choose Records > Edit Local Record.

W Virtua - Phoeni=01

mE %]

Fll_S-nurd'l Circulstion  Acquiskions Options Tools Window Help

Close Connecticn...

Connection List...

'!B@ BDR|B®| |

:l:i.rrmt connection: Phoenib0l

& [

= g O

Change Password [

Records 3
‘Workforms ¥

Print Thank You Letbers. ..
Clear Thank You Information

Frinter Setup
Rieceipt Printer Setup

Exit

At

Creabe Record. ..

Creabe Line Ibem/Accession Bib
Edit [tem Records. ..

Extract Local Record...

Drelete Local Recard., ..

Trarslsbe Records..,

Import Recards, ..

Import Records To Selection List...
IrporEEDIMARCR ecordshetion

The Edit Local Record window appears.

Edit Local Record

~| « @&k E-

I5)Mappings
|53 Mews Fixed Field Files
I Mew Workforms

labels,rec
MaRCDump, rec
Moore, rec

simplelabels,rec

verghese, rec

ICIMsSaw anan . Fec

I validate samplelabels.rec

jgreen,rec SavedCopies.rec

Fil= name: |“.reu: Open

Files of type: | Record Files [*rec)

[_Geen |
;I Cancel |
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Select a file from the list of files with *.rec extensions. Click the Open button.

e If the file contains only one record, the MARC Editor appears.
e If the file contains more than one record, the Select Record window appears
with a list of MARC records from the selected file.

Note: Virtua reads any file regardless of its name and extension as long as the file
is composed of MARC communication records. However, Virtua defaults to
displaying files with a .rec extension.

-~

¥ Select Record - Phoenix01 E]@-\

File: Z:\Program Files\YTLS\Wirtuad9, 3. 54Catalog)SavedCopies.rec
Records

The story of Edgar Sawtelle ;& novel f David Wiroblewsk,

The fountainhead | Awn Rand ; with a special introduction by the author ; afterword by Leonard F'E|kJ:-FF
The fountainbiead | Avn Rand ; with a special introduction by the author ;) afterword by Leonard Peikaff,
Breaking dawn | Stephenie I"-’Ieyer.

A thousand splendid suns | Khaled Hosseini,

‘ou suck.: a love story [ Christopher Moore,

=

Edit Exctract Prewview Cancel

Select record(s) using one of the following methods:

e An individual record by clicking the record
Multiple adjacent records by highlighting the first one, then holding down the
Shift key and clicking on the last one.

e Multiple individual records by holding down the Control key and clicking on
each record.

Preview, Edit, Extract Local Records

After selecting the local records with which you want to work, you may want to
preview them before editing or extracting them.

Preview Local Records
On the Select Record window, click the Preview button.

The Record Previewing window appears, displaying your record selections in
order and in a format that allows you to preview them before editing them.

Basic Cataloging Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



P a1
W Record Previewing - Phoenix(01 E]@
: SavedCopies.recil {| savedCopies rec:2 ] SavedCopies.rec:3 | SavedCopies.rec:4 ] SavedCopi 4 | *
LDRO1346cam 2200337 a 4500 Y

00115390753
00520050808135305.0
0050807312008 nyu 000 1engd

06ta 7 \b cbe o copycat id 1 e neip \f 20 Y v-gencatlg

Q25003 acquire b 2 shelf copies \x policy default

95514 pvl 1 2008-07-31 z-processor HAMD CARRY 2 copies to HLCD 3 Ih0S 2005-058-05 12 [h03
2005-05-05 ko BCCD

010%a 2008276076

020%a 9780061374227

02044 0061374229

035ha (OColClocnl 79505747

040ta BTCTA e ETCTA td BAKER \d YDRCP \d ILC \d 253 \d €0 \d DLC

0424 a lccopycak

043ha n-us-wi

05000%a PS3623.R63 b 576 2005

05204 513).6 12 22

1001'%a Wroblewski, David,

24514%a The story of Edgar Sawtells : b a novel [ ic David Wroblewski,

250ha 1st ed.

260ha Mew York ; 'b Ecco, Yo c2008, o=

DO A 2L - 0 b A e

To preview a specific record click the appropriate tab across the top of the

Record Previewing window

Edit or Extract Local Records
On the Select Record window click the Edit or Extract button.

Edit: The selected records are placed in the MARC Editor and the original

records remain in the file.
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Extract: The selected records are placed in the MARC Editor and the original

records are deleted (extracted) from the file.

Click the desired tab along the bottom of the editor window. If the tab you want
is not visible, click the directional arrows in the bottom right corner.

All editing functions are available to you.

Validate Record

See Record Validation.

Save Record

Save it to the database (F11)
Append it to an existing local file
Replace a record in a local file
Save the record to a new local file

See Record States.
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Delete Local Records

Once records are saved to the Virtua database you might want to delete the local
records if you did not extract them, to avoid duplication of records.

Records may be deleted individually or an entire file of records may be deleted.

Delete Individual Records

On the Virtua menu bar, click File > Records > Delete Local Record. The
Delete Local Record window appears, displaying a list of local record (*.rec)

files.

-~

Delete Local Record

Ax]

| Mappings

|y Mew Fixed Field Files
| Mew Workforms
CINSSAW

|hvalidate

jareen.rec

labels.rec
MARCDump. rec
Moo, rec

onan. rec
samplelabels.rec

SavedCopies.rec

=l cF E-
simplelabels.rec
verghese, rec

File name: *1en

Filez aof type: |Fh3|:l:|rd Files [*.rec)

ﬂ Cancel

Select the file from which you want to delete the desired record(s).

114

Click the Open button. The Select Record window appears, displaying all the
records in the local file you selected.

W Select Record - Phoenix01

mEx]

Records

File: «ZiProgram FilesiWTLSVirtuad9, 3,50 Catalog)SavedCopies, rec

. The stary of Edgar Sawtelle : a novel | David Wroblewsk,

. The fountainhead / Avyn Rand ; with a special introduction by the author ; afterword by Leonard Peikoff,
. The fountainhead | Avn Rand ; with a special introduction by the authar ;) afterword by Leonard Peikaff,
Breaking dawn | Stephenie Meyer,
A thousand splendid suns | Khaled Hosseini,

i e o =

You suck : a love skory | Christopher Moore,

Delete Prewview Cancel
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Select the record(s) you want to delete.

Click the Delete button. The system asks you to confirm the deletion.

[ 1

Confirm

b Are you sure vou want to delete the selected recards?

Mo Zancel |

Click the Yes button. A dialog box appears telling you how many records were
deleted.

Click the OK button.

Delete a File of Local Records

You can delete an entire file of local records in two ways. You can use Windows
Explorer to delete the file, or you can delete the file using Virtua’s Delete Local
Record function. When you delete a file using the Delete Local Record function, you
must first delete ALL the records in the file.

On the Virtua menu bar, click File > Records > Delete Local Record. The
Delete Local Record window appears displaying a list of files.

Select the file to delete.

Click the Open button. The Select Record window appears, displaying all the
records in the local file you selected.

Select ALL the records in the window.
Click the Delete button.

Click the OK button.
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Cataloging Reports

Authorities List

Bibliographic Record List

Broad Cataloging Statistics
Cataloger Productivity
Cataloging Errors

Change Item Location by Call Number Range
Indexed Words

Item Barcode List

Items Created List

Items Received List

Legal Deposit Statistics
Number of Records in Database
Production of Records by User
Record Extraction Utility
Record Modification Utility
Records By State

Subject Bibliography

URL Checker
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Appendix A - Changes in this
Guide

Changes for Version 16.1

No changes were made.
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